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About GeoSyn 2D

About GeoSyn 2D
GeoSyn 2D is a two-dimensional seismic modeling program designed to quickly
turn cross section depth models into pseudo seismic sections. With complete
depth and time perspective, geoscientists have the ability to build structural and
stratigraphic models using IHS Digital Logs or LAS files.

Multiple combinations of reservoir properties and geometries can produce the
same seismic signature. Using GeoSyn 2D allows you to generate multiple scen-
arios of petrophysical changes in the subsurface and determine the relationship
between seismic data and those subsurface changes.

Using GeoSyn 2D you can:

l Predict petrophysical and reservoir features of interest such as lithology,
fluid composition, porosity from seismic data Predict petrophysical and
reservoir features of interest such as lithology, fluid composition, poros-
ity from seismic data.

l Understand the sensitivity of seismic data to lateral and vertical changes
in lithology, fluid, and porosity along and in between wells Understand
the sensitivity of seismic data to lateral and vertical changes in lithology,
fluid, and porosity along and in between wells

l Automatically generate synthetic seismic response data from a geo-
logical model of well data.

l Compare the synthetic seismic response data to real seismic data with
the assumption that a similarity in seismic response indicates similar
underlying rock properties such as lithology, fluid, and porosity.

Main display
The default view displays a single model with tabs that allow you to switch
between depth and time. In version 2017 and later, both time and depth models
can be displayed simultaneously in separate windows.

To view time and depth models in separate windows:

l From the tool bar, Click the dual windows button

l From the menu, View > Two pages

© 2020 IHS Markit™. All Rights Reserved 1



About GeoSyn 2D

.

Note: Depending on the complexity of your model, viewing both time and
depth models simultaneously in AVO mode can impact per-
formance. If you notice that your systems performance is reduced,
switch back to the default single model view.

Display time model.

Display depth model.

Display time and depth models in separate windows.

Display single chart in primary window.

Display parameters dialog, used to set display parameters for depth,
time, wells, global parameters and map.

Edit labels

Edit Wavelet, allows user to edit wavelet properties and spectrum’s.

Port hole, captures the portion of the time model currently displayed
in the resulting Port Hole window.
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About GeoSyn 2D

Create a new correlation

Edit correlations / nodes

Edit zone parameters

Create well correlations automatically.

Crossplot wizard

Set default configurations

The status bar provides model information relative to cursors X and Y position.
Displayed parameters include: Offset, Depth, Time, Velocity and Correlation
when applicable.

Recommended system specifications
IHS recommends the following system specifications:

Hardware

Minimum 64-bit quad-core machine with 8 GB of physical RAM

Recommended 64-bit processor with 8 CPU cores and 16 GB of physical
RAM or higher

Recommended
Graphics card:

Video cards that support CUDA 4.x, have at least 1 GB
of graphic card memory

Operating System Install Supported

Windows 7 SP1 (64-bit) Yes Yes

Windows 8 Yes * Basic *

Windows 10 Yes Yes

Windows 2008 R2 Server (Citrix based
Applications)

Yes * Basic*

Windows 2012 Server (Citrix based Applic-
ations)

Yes * Basic*

* Basic support; Customer Care support provided but OS not certified.

© 2020 IHS Markit™. All Rights Reserved 3



Changing global properties

Changing global properties
Configure general options in the main display including:

l Time and depth banners

l Measurement units used throughout GeoSyn

l Printer scale

l Print page border on time and depth pages.

Once a model is configured, save the display options in an import default file that
applies to all new models.

To change global properties:
1. Open the Display Parameters: Global dialog box:

l From the menu, Edit>Display Parameters

l From the tool bar, click on the main toolbar

2. Change configuration settings as needed:

l Enter a banner to appear on both time and depth pages and click
Update.

l Select unit of measurement: Metric or Imperial units then specify related
sub unit (Meters/Kilometers or Miles/Feet)

l Select Sonic unit: Transit or Velocity

l Select whether a print page border that bounds the portion of the time
and depth models that will be printed appears on the canvas in the main
display. You can change the size of the print page border by configuring
the page size for your printer (for details, see Related Topics below).

3. Click Close.

Note: These changes only apply to the current model

Related Topics
"Main display" on page 1
"Printing models" on page 140
"Changing import defaults" on page 13
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Configuring GeoSyn defaults
GeoSyn enables you to change basic configuration details that apply to all
GeoSyn sessions, including:

l GeoSyn file directories

l Communication addresses

l IHS data retrieval credentials

l How imported logs are interpreted and displayed

Configuration changes made are automatically applied to this and future GeoSyn
sessions.

To configure GeoSyn defaults:
1. Open the Configuration Properties dialog box:

l From the menu, Edit > Configuration Properties

2. Change configuration settings as needed.

3. Click Close.

Note: Configuration changes are automatically applied to this and future
GeoSyn sessions.

Related topics
"Changing log display properties" on page 106
"Changing import defaults" on page 13
"Contacting Customer Care" on page 12

Changing log definitions
GeoSyn maintains a centralized database file of log definitions
(LogInit50.gld)where you can customize settings such as:

l Track widths

l Scales

l Aliases

l Color fills

l Several others
Settings are applied only to new models whose log settings have not already
been defined in the import defaults file.

© 2020 IHS Markit™. All Rights Reserved 5
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To change log defaults:
1. Open the Properties: Log Definitions dialog box Edit > Configuration
properties > Log Library.

2. In the tree displayed, click the plus sign (+) beside the appropriate
node to expand it and view current configuration details.

3. Click Edit curve to open the Edit Default Display Properties dialog box

4. Configure the curve properties then click OK to return to the Prop-
erties: Log Definitions tab.

5. Click Close to return to the main display. The changes you made are
applied to future models providing a different setting doesn't exist in
the import defaults file for that model.

Import defaults file
The import defaults file usually contains all default settings except those that
apply to logs. When you update the import defaults file with settings from the cur-
rent model, settings for log types in the current model are also written to it. Log
settings in the import defaults file override, but don't overwrite settings in the log
definitions database.

When GeoSyn creates a model, it first checks whether display settings for the
logs upon which the model will be based exist in the current import defaults file. If
they do, GeoSyn uses them instead of the settings in the log database.

Related Topics
"Changing import defaults" on page 13
"Changing log display properties" on page 106

GeoLaunching GeoSyn 2D from Kingdom
Launch GeoSyn 2D from IHS Kingdom to create time-depth models based on
Kingdom wells.

When launched from Kingdom, GeoSyn creates a GeoSyn directory under the
Kingdom project directory. All GeoSyn data associated with the model you create
is written to this location.

To launch GeoSyn from Kingdom:

1. From within Kingdom:

6 © 2020 IHS Markit™. All Rights Reserved
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l Right-click on a single well on the base map or Project Tree and select
GeoSyn. This will launch GeoSyn and give you the option of importing the
well using Quick Start.

l Select Yes to automatically import the well using the default sonic,
VSD seismic, and density logs bypassing the need to manually
enter the information.

l Select No to import the well and manually enter your information
starting in step 2 of the procedure described below.

l From the Project orWells menu, click GeoSyn.

Opening GeoSyn from the ProjectorWells menu data is imported for all of
the wells on the Kingdom project's visible well list. Some of the wells on the
Kingdom base map may be hidden, but can still be retrieved using GeoSyn at
any time.

© 2020 IHS Markit™. All Rights Reserved 7
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The Kingdom Data Browser dialog box appears.

Filter the results displayed by clicking check boxes to the right of the Hide if well
label, and select the columns to display by clicking check boxes to the right of the
Identify by label.

Where the well includes a directional survey, select whether to convert it to true
vertical depth.

2. Select the desired wells, and then click OK

The Import Log Data dialog box opens.
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3. Select the wells and curves to import, and then click Begin.
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The Import KingdomWell Data and Apply Corrections dialog box appears.

Click View and Edit to display the Time/Depth Quality Control dialog boxes
where you apply changes to the time depth curve before applying it to the sonic.
Note: In order for changes made using the Time/Depth Quality Control dialog
boxes to be applied, upon exiting that dialog box, when the Save Modified
Time/Depth Chart dialog box appears, you must click Save.

4. Click Import... to apply the changes, or click Skip to ignore the well.

The Populate the GeoSyn2D Tops List dialog box appears.
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5. Select the tops repository into which to import the tops from the wells, and
then click OK.

GeoSyn gives you the option to run the automatic correlation wizard. See Related
Topics for details.

Related Topics
"Downloading logs from the IHS information hub" on page 15
"Importing LAS or GeoSyn files from disk" on page 18
"Creating correlations" on page 94
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Contacting Customer Care
Contact IHS Customer Care for assistance with any questions or problems not
answered in this help system.

Phone 1 800 IHS-CARE (1 800 447-2273)
Mon. to Fri. 8:00 AM to 6:00 PM

Email Kingdom users: kingdom_support@ihsmarkit.com
Non-Kingdom users: support.cdn@ihsmarkit.com

Web
site

www.ihs.com/products/oil-gas-geosyn-soft-
ware.html

When reporting a difficulty, please include any information that might help us dia-
gnose the problem including the following:

l Version of GeoSyn (and AccuMap, if installed)

l Windows operating system

l Circumstances and steps that led to the problem

l Complete text from any error messages

Related Topics

"Recommended system specifications" on page 3

12 © 2020 IHS Markit™. All Rights Reserved

mailto:kingdom_support@ihsmarkit.com?subject=GeoSyn support question
mailto:support.cdn@ihsmarkit.com?subject=GeoSyn support question
http://www.ihs.com/products/oil-gas-geosyn-software.html
http://www.ihs.com/products/oil-gas-geosyn-software.html


Importing Wells

Importing Wells
With GeoSyn 2D you can import wells in .las or .syn format from disk or the IHS
Information Hub. When importing wells, GeoSyn alerts you if a well doesn't have
any tops and prompts you to copy the tops from another well in your model to the
well without tops. The copied tops are evenly spaced in the well into which
they're copied and you manually adjust them.

When importing wells:

l Use the GeoSyn 2D Directory Browser, to select .LAS and GeoSyn files.
Directory Browser enables you to sort and manage numerous files based
on Unique Well Identifier (UWI) instead of file name.

l Import any number of wells into a blank depth page

l Always import one well at a time If importing wells into an existing depth
page with previously imported wells.

Changing import defaults
Import the control path settings and display parameters for everything in a new
synthetic except logs from a default file. Log default settings are controlled by a
centralized log database with one exception: when you update a default file with
settings from the current model. Settings for the logs in the current model are
saved to the import defaults file but don't overwrite settings in the log defaults
database.

GeoSyn allows you to create unique default files for different projects with dif-
fering criteria, or several default files for the same project to switch between for
viewing different scenarios. Defaults can either be applied to the current model,
or the parameters set in the current model can be applied to a default file that
you then save for future use.

To change import defaults:
1. Open the Configuration Properties dialog :

l From the menu, Edit > Configuration Properties > Import defaults
tab

l From the tool bar, click on the main toolbar

2. Select an import defaults file to modify for click New to create a new
file.

© 2020 IHS Markit™. All Rights Reserved 13
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3. Click Update model with current default file Applies changes from selec-
ted default file to the current mode.

Note: The nodes in the import defaults file tree displays settings from
the selected file. Nodes can be expanded for viewing current set-
tings. To change the settings, use the Display Parameters ( )
option from the model window.

4. Click Close to return to the model display with your changes applied.

The current default file is automatically selected the next time you launch
GeoSyn and is applied to all future models derived from imported logs.

Related Topics
"Configuring GeoSyn defaults" on page 5
"Changing log definitions" on page 105
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Downloading logs from the IHS information hub

Downloading logs from the IHS inform-
ation hub
With a subscription to the IHS Information Hub, select a specific UWI or a range
defined by NW and SE corners from which to download specific logs. You can also
download directional surveys (if licensed) and request IHS digitize service
curves.

If your subscription is transactional, GeoSyn can warn you before downloading
digits from the hub to eliminate unexpected charges.

GeoSyn curves are automatically saved in .las format in the GeoSyn target dir-
ectory.

To download logs from the IHS Information Hub:

1. From the Filemenu, select Import, and then Data Search Wizard.

The Define search range dialog box appears.

© 2020 IHS Markit™. All Rights Reserved 15



Downloading logs from the IHS information hub

2. Click either Add Location or Add Range to display the Edit a UWI dialog box
and specify the survey system and coordinates of the well(s) for which to retrieve
logs.

To change your IHS Information Hub connectivity parameters or GeoSyn default
directories, click Edit online configuration to display the Configuration dialog
box. For network installations, hub connectivity parameters affect all GeoSyn
users.

3. Click Next.

The Select data from catalog dialog box appears.

4. Click Display Layout to show the Catalog display options dialog box and con-
figure the options with which to sort and filter the wells that appear in the above
dialog box. Filter by column order (by dragging and dropping mnemonics in the
display pane), row sorting, and whether wells without digital sonic and density
logs or less than a certain depth appear.
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Downloading logs from the IHS information hub

A check mark ( ) appears beside logs that will import, a cross ( ) beside those
that won't. Logs with true vertical depths and measured depths can't be selected
during the same import.

5. Select the options by which to filter whether wells appear in the display pane
and whether to group the overlapping portions of multiple runs from the same
source.

6. Click Next.

The Define save options dialog box appears.

7. Select the locations in which to save downloaded files and whether to import
downloaded logs into the GeoSyn model during the download. The above options
are defined in the Properties: Import Defaults dialog box, which can be accessed
by clicking Edit Defaults above.

If you save logs to disk and then import them into the model from disk, you
can restrict the depth range.

8. Click Next.

© 2020 IHS Markit™. All Rights Reserved 17



Downloading logs from the IHS information hub

The specified logs are downloaded from the IHS Information Hub and the results
are listed in a summary report dialog box that you can save to an ASCII format
file to log downloads.

9. Click Close.

If you're importing a well into a model that already contains wells, your cursor

becomes a placement hand ( ) and you click the location in which to place the
well. If the well intersects a correlation, the Insert a Well into an Existing Model
dialog box appears and you correlate tops in the well to place to the correlations
it intersects by clicking first the top to link in the left pane and then the cor-
relation name in the right pane. You can also click Edit to display the Top Prop-
erties dialog box and create a top in the well to place that you then link using the
method above.

Related Topics
"Changing import defaults" on page 13
"GeoLaunching GeoSyn 2D from Kingdom" on page 6
"Importing LAS or GeoSyn files from disk" below

Importing LAS or GeoSyn files from disk
In order to import LAS or GeoSyn files from disk, the current GeoSyn session can
not have been launched using Kingdom.

GeoSyn enables you to create a model by importing raw log data from either LAS
or GeoSyn files.

When you import a GeoSyn or LAS file, GeoSyn renders the file using the settings
in the import defaults file and loads the formation tops defined in the well from
your local AccuMap system tops and AccuMap user tops databases. For details on
changing import default files, see Related Topics below.

To import logs or GeoSyn files from disk:

1. From the Filemenu, select Import >Wells.
OR
with GeoSyn open and a blank GeoSyn canvas displayed, simply drag the .las file
from a Windows location onto the canvas.

The Select Log Data form GeoSyn or LAS Format Files dialog box appears.

18 © 2020 IHS Markit™. All Rights Reserved



Downloading logs from the IHS information hub

2. Select the root directory or drive from the Look in drop-down list then double-
click folders in the display pane and browse to the directory that contains either
the desired files or the subdirectories with those files. To filter the type of files dis-
played, from the Files of type drop-down list, select a file format extension.

3. Either click Browse Directory or Browse subdirectories to launch Directory
Browser, or simply select the desired file in the display pane and click Select. For
details on using Directory Browser, see Related Topics below.

The wells are automatically placed on the new model.

If you're importing a well into a model that already contains wells, your cursor

becomes a placement hand ( ) and you click the location in which to place the
well. If the well intersects a correlation, the Insert a Well into an Existing Model
dialog box appears and you correlate tops in the well to place to the correlations
it intersects by clicking first the top to link in the left pane and then the cor-
relation name in the right pane. You can also click Edit to display the Top Prop-
erties dialog box and create a top in the well to place that you then link using the
method above.

If the import file has missing or invalid data such as an invalid UWI or log alias,
GeoSyn enables you to correct it during the import. For details, see Related Top-
ics below.

Related Topics
"Changing import defaults" on page 13
"Using Directory Browser" below
"Changing log display properties" on page 106
"Correcting invalid data when importing" on page 21
"GeoLaunching GeoSyn 2D from Kingdom" on page 6
"Changing depth models" on page 91

Using Directory Browser
The GeoSyn Directory Browser displays and sorts the contents of LAS and
GeoSyn files by UWI rather than file name in selected directories and associated
sub-directories. Sorting by UWI instead of a file name allows users to:

l Filter files by geographic coordinates

l Sort by various UWI columns

© 2020 IHS Markit™. All Rights Reserved 19
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l View basic details about the individual files before opening or importing

UWIs are listed in the appropriate survey system tab separated into columns rep-
resenting each coordinate group of the survey system. Log files with missing or
invalid UWIs are only listed in the Labels tab

Cataloging files
The first time it reads a directory, the Directory Browser creates a catalog file
(.cat )of all (.las) and GeoSyn files in the selected directories . Depending on

the volume of files, this can take several minutes as each file is read and cata-
loged. As a best practice and to reduce time, search directories should only
include..las and ..syn files.

Note: Corrupt GeoSyn files in the target directory may cause Directory
Browser to crash.

To use Directory Browser:
1. From the Filemenu, select Import log data.
The Import log data dialog box will open.

2. Select a directory path from the drop down list .

3. Click one of the action buttons to open the Directory Browser:

l Browse dir, Opens Directory Browser with files in current directory
only.

20 © 2020 IHS Markit™. All Rights Reserved



Downloading logs from the IHS information hub

l Browse sub-dir, Opens Directory Browser with files in current dir-
ectory and sub directories

4. Select the desired survey system tab and then click a column header
to sort rows based on the values in that column or change the column
order by clicking transpose ( ) between two columns to swap.
To remove UWIs that appear outside of a certain geographic boundary,
select Filter then click Edit to display the Edit a UWI dialog box and
specify the coordinates for the area within which to display UWIs.

5. Right-click a row to view a popup window with basic log details.

6. Select the row to open or import into GeoSyn file and click Open. Addi-
tionally you can:

l Click a column header to sort rows based on column values

l Change the column order by clicking transpose between two columns
to swap

l Remove UWIs that appear outside of a certain geographic boundary

l Select Filter then click Edit to display the Edit a UWI dialog box and
specify the coordinates for the pane within which to display UWIs.

l Right-click a row to view a popup window with basic log details.

l Click Report to display the Browser report dialog box.

Related Topics
Importing LAS or GeoSyn Files from Disk
Changing Import Defaults

Correcting invalid data when importing

Warning messages allow you to correct information during an import if:

l kelly bushing or depth increment of the imported file and the current syn-
thetic don't match.

l the UWI is missing or invalid

l specific logs are missing

l log aliases are missing or unrecognized

l sonic and density log units don't match

Note: You can change general synthetic display properties if you don't
want to be notified of missing or an invalid UWI or unrecognized log
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aliases.

Problem Resolution

Kelly bushing and the current
synthetic don't match.

GeoSyn offers to automatically depth shift
the imported log to match the kelly bushing
depth of logs in the current synthetic. Altern-
ately, you can change the kelly bushing
depth for the current synthetic:

Missing or invalid UWI l Modify the UWI and or labels before
continuing.

l Ignore the UWI and build the synthetic.

Missing or invalid log alias Logs associated with the GENERAL alias may
not display correctly and GeoSyn won't
recognize them as logs of importance (sonic,
density, etc).

The sonic log is missing GeoSyn can create a constant velocity sonic
log.

The sonic log has invalid
data.

GeoSyn can either reduce the sample rate
until the integrated sonic data falls below
the program limits or abandon the import.

The sonic and density units
don't match.

GeoSyn issues a warning and automatically
corrects the problem.

Importing data into a pre-
existing synthetic with dif-
ferent parameters (different
KB, different depth incre-
ment, etc.) than the impor-
ted file. 

GeoSyn issues a warning and can correct all
the problems before you import the data.

Related Topics
"Importing LAS or GeoSyn files from disk" on page 18
"Changing log definitions" on page 105
"Configuring GeoSyn defaults" on page 5
"Downloading logs from the IHS information hub" on page 15
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Importing directional surveys
You can import and modify a directional survey saved in ASCII, GeoGraphix, or
Open Works format, or create one from scratch by typing measured depth, dip,
and azimuth values.

If a well from the IHS Information Hub has a directional survey available and
you're licensed to access directional surveys, you can save it to disk while down-
loading the log and then import it into GeoSyn. For details, see Related Topics
below.

To import a directional survey:

1. In the depth page, right-click the well for which to import a directional survey
and from the shortcut menu, selectWell properties.

The Well Properties: Well Properties dialog box appears.

2. Beside the TVD corrected check box, click Import directional survey.
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The Measured Depth to True Vertical Depth correction dialog box appears.

3. Either click Import Survey and browse for the desired directional survey file
or type individual depth, dip, and azimuth values in the dialog box above and click
Insert.

The Import Directional Survey dialog box appears.

If importing a file, complete the following bulleted steps:

Browse to the file to import then click Open.
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The Highlight first line dialog box appears.

Select the first line to import and click Next.

The Highlight last line dialog box appears.

Select the last line to import and click Next.
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The Set column delimeters dialog box appears.

Set the column delimeters ( ) by clicking in the display pane between required
columns. The green line cannot bisect a data column. Double-click column delim-
iters to delete.

Click the box that appears below each delimeter to display the
Select from List dialog box and identify the data type then click
Next.
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The Finish dialog box appears.

Click Finish.

The Measured Depth to True Vertical Depth correction dialog box appears, pop-
ulated with the typed or imported values.

4. Do any of the following:

To modify or add values, select the row to replace, or type values in the MD, Dip,
and Azimuth boxes, and then click either Update or Insert.
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To delete a row, select it in the display pane and click Delete or click All to clear
the entire display pane.

To save the display pane to an ASCII format file, click Save Report.

5. Click Apply and Close to complete the import.

GeoSyn imports the data and displays the deviated log in the main display, where
you can adjust the azimuth of the projection using theWell Properties: Dir-
ectional Survey dialog box. For details seeRelated Topics below.

Related Topics
"Changing deviated well properties" below
"Downloading logs from the IHS information hub" on page 15

Changing deviated well properties
Import a directional survey saved in GeoGraphix, Open Works, or ASCII format.
When the directional survey is applied to the model, display it showing deviation
calculated from a projection of the wellbore onto a user-selected azimuth.

GeoSyn 2D cannot display the offset in the model because it complicates inter-
polating the velocity field.

You can only modify directional properties after you import a directional survey.
For details, seeRelated Topics below.

To change deviated well properties:
1. On the depth page, right-click a well with a directional survey to import
and from the shortcut menu, selectWell properties > Directional
properties.
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The Well Properties: Directional properties dialog box appears.

2. Hover the cursor ( ) over the display pane and move it along the devi-
ation line to view the Eastings and Northings.

3. Do either of the following:

l Type a value in the Projection azimuth box.

l Hover the cursor over the compass. The cursor becomes a hand ( ).
Click and hold while dragging the dashed red projection line (oriented
north-south by default), and release the mouse button to place the line.

4. Click Update to see the effects of your changes on the main display
then click Close.

Related Topics
"Importing directional surveys" on page 23
"Changing well display properties" on page 88

Managing tops
GeoSyn includes four default lists for tops:

l Generic, which are tops listed in the imported LAS log files.
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l AccuMap System Tops, which are always loaded from your local
AccuMap database when you create a new model or launch an existing
one. information for these tops may change following AccuMap data
loads.

l AccuMap User Tops, which are always loaded from your local AccuMap
user tops database when you create a new model or launch an existing
one. Information for these tops changes based on changes you make.

l GeoSyn 2D Tops. Only tops that appear in the GeoSyn 2D Tops list can
be used for correlation. During a well log import, GeoSyn automatically
creates andpopulates this list. When importing GeoSyn 1D .syn files, the
GeoSyn 2D Tops list is populated from the generic tops list associated
with the LAS file. Using the Top Properties dialog box, you can update
this list by copying tops from other lists.

You can create an unlimited number of tops lists with customized depths, copy
tops amongst lists, and delete individual tops in lists. You can't delete the four
default lists above, but you can delete the tops within.
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Changing tops properties
When you create a new synthetic or launch an existing one, GeoSyn auto-
matically downloads the latest system tops and user tops from the local AccuMap
database or the IHS Online Information Hub. If importing an LAS or GeoSyn file,
you specify whether the well is in measured depth or true vertical depth units so
the tops are placed at the correct depths.

The display properties of tops including formation name, depth, marker attrib-
utes, and lithology can be modified. Customized tops can be copied to multiple
tops lists and displayed in the main synthetic display.

Important: Changes you make in the GeoSyn user tops list in aren't
updated in the AccuMap user database and will be over-
written by the AccuMap user database the next time you
launch the synthetic. To change the value in the AccuMap
user database, use AccuMap Tops Manager. To prevent the
changed depth from being overwritten without changing the
depth in the AccuMap user database, copy the top to the
Generic tops list.

To change tops properties:
1. Launch the Tops Properties dialog box:

l Menu: Edit >Tops properties

l Depth model: Right click on a log and select Tops properties.
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2. Select a list to display from Tops lists.

3. Choose a top to change from the selected list Tops: [List name].

4. Change the tops display properties in the Edit top(s)section.

5. Click Close to return to the main synthetic display with the changes
applied.

Related Topics
"Importing tops from delimited files" below
"Exporting tops lists" on page 146
"Managing tops" on page 29
"Importing tops from fixed width files" on page 35
"Importing tops from GeoSyn files" on page 42

Importing tops from delimited files
You can import tops lists saved in delimited ASCII format files into GeoSyn tops
lists so that they are available to your current model. Delimiters can include com-
mas, tabs, or spaces.
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Delimited format is different than fixed width columns. All entries in fixed width
columns align on the left-edge of the column. Delimited simply includes one or
more delimiters between entries, but the items may not align neatly in columns.

When importing tops, you have the option of overwriting existing tops in the list.
If you keep the current tops, imported tops with the same name appear alongside
them.

To duplicate and then modify an existing tops list within GeoSyn, see Related Top-
ics below.

To import tops from delimited files:

1. Right-click a log and select Tops properties.

The Top Properties dialog box appears.

2. Below the Tops Lists pane to the right, beside the Import button, select Delim-
ited, rows or columns from the drop-down list.

3. Click Import.
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The Import Delimited Tops File dialog box appears.

4. Browse to the desired tops file, and then click OK.

The Tops Import dialog box appears.

GeoSyn automatically searches in the file you selected above for a UWI that
matches the one in your GeoSyn file and highlights the row in which it appears in
the tops source file.

5. Using the display pane, verify whether the tops in the source file are ordered in
rows (formation top names run horizontally along a single row), or columns (form-
ation top names run vertically down a single column).
Your selection above is saved and applied the next time you launch the Tops
Import dialog box.

6. Using the Names in row or column and the Depths in row or column (depending
on whether you selected Tops in rows or Tops in columns above), specify the row
or column in which the formation top names and depths appear.

7. In the from and to boxes, specify the range to import.
OR
Drag in the display pane to select the tops to import.
Rows are highlighted gray simply to show the columns and rows in which
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formation top names and depths appear. Rows and columns highlighted green are
those that will be imported into GeoSyn.

Verify the delimeter GeoSyn chose is correct. GeoSyn attempts to determine the
correct delimeter by reading the source file.

In the Top placement pane, select the desired processing options.

8. Click Apply.

The Select a recipient tops list dialog box appears.

9. Select the list to which to import the tops or click New top list, define a new
tops list, and then click OK. Shift+Click or Ctrl+Click to select more than one tops
list to import into the list of tops.

Related Topics

"Duplicating tops lists" on page 49 "Managing tops" on page 29

"Importing tops from fixed width files"
below

"Importing tops from GeoSyn files" on
page 42

Importing tops from fixed width files
You can import tops lists saved in LAS, or ASCII format into the GeoSyn tops list
so that they're available to your current model.

Fixed width columns format is different than delimited format. All entries in fixed
width columns align on the left-edge of the column. Delimited simply includes one
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or more delimiters between entries, but the items may not align neatly in
columns.

When importing tops, you have the option of overwriting existing tops in the list,
if you keep the current tops, imported tops with the same name appear alongside
them.

To duplicate and then modify an existing tops list within GeoSyn, see Related Top-
ics below.

To import tops from fixed width files:

1. Right-click a log and select Tops properties.

The Top Properties dialog box appears.

2. Below the Tops Lists pane to the right, beside the Import button, select Fixed
Width, Delimited columns only from the drop-down list.

3. Click Import.
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The Import Tops dialog box appears.

4. Browse to the desired tops file and select the depth placement options, units,
and whether to delete current tops if importing into a tops list that's already pop-
ulated, and then click OK.
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The Highlight first line dialog box appears.

5. Select the row in which the first top appears, and then click Next.
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The Import Wizard: Highlight Last Line dialog box appears.

6. Select the row in which the last top appears, and then click Next.
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The Import Wizard: Set Column Delimeters dialog box appears.

Set the column delimeters ( ) by clicking in the display pane between required
columns. The green line cannot bisect a data column. Double-click column delim-
iters to delete.

Click the box that appears below each delimeter to display the
Select from List dialog box and identify the data type then click
Next.
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The Import Wizard: Finish dialog box appears.

7. Click Finish.

The Select a recipient tops list dialog box appears.

8. Select the list to which to import the tops or click New top list, define a new
tops list, and then click OK. Shift+Click or Ctrl+Click to select more than one tops
list to import into the list of tops.
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Related Topics
"Duplicating tops lists" on page 49
"Managing tops" on page 29
"Importing tops lists" on page 45
"Importing tops from delimited files" on page 32

Importing tops from GeoSyn files
You can import tops lists saved in GeoSyn format into the GeoSyn tops list so that
they're available to your current model.

When importing tops, you have the option of overwriting existing tops in the list,
if you keep the current tops, imported tops with the same name appear alongside
them.

To duplicate and then modify an existing tops list within GeoSyn, see Related Top-
ics below.

To import tops from GeoSyn files:

1. Right-click a log and select Tops properties.
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The Top Properties dialog box appears.

2. Below the Tops Lists pane to the right, beside the Import button, select
GeoSyn from the drop-down list.

3. Click Import.
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The Import Tops dialog box appears.

4. Browse to the desired GeoSyn file and select the depth placement options,
units, and whether to delete current tops if importing into a tops list that's
already populated, and then click OK.
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The Select a recipient tops list dialog box appears.

5. Select the list to which to import the tops or click New top list and define a
new tops list, and then click OK. Shift+Click or Ctrl+Click to select more than one
tops list to import into the list of tops.

Related Topics
"Duplicating tops lists" on page 49
"Importing tops lists" below
"Managing tops" on page 29
"Importing tops from fixed width files" on page 35

Importing tops lists
You can import tops lists saved in GeoSyn, LAS, or ASCII format into the GeoSyn
tops list to make them available to your current model. When importing tops, you
have the option of overwriting existing tops in the list, if you keep the current
tops, imported tops with the same name appear alongside them.

To duplicate and then modify an existing tops list within GeoSyn, see Related Top-
ics below.

To import tops lists:

1. Right-click a log and select Tops properties.

© 2020 IHS Markit™. All Rights Reserved 45



Changing tops properties

The Top Properties dialog box appears.

2. In the Tops Lists pane to the right, select whether the desired tops are in
GeoSyn or delimited format, and if delimited (by tabs, commas, or spaces),
whether the tops appear in the file either in rows or in fixed width columns.

Space delimited and fixed width columns are not the same thing. All entries in
fixed width columns align on the left-edge of the column. Space delimited
simply includes one or more spaces between entries, but the items may not
align neatly in columns.

3. Click Import.
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Either the Import Tops dialog box (depicted below) or the Import Delimited Tops
File dialog box appears.

4. Browse to the desired tops file and select the depth placement options, units,
and whether to delete current tops if importing into a tops list that's already pop-
ulated, and then click OK.
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The Tops Import dialog box appears.

GeoSyn automatically searches in the file you selected above for a UWI that
matches the one in your GeoSyn file and highlights the row in which it appears in
the tops file.

5. Using the display pane, verify whether the tops in the source file are ordered in
rows (formation top names run horizontally along a single row), or columns (form-
ation top names run vertically down a single column).
Your selection above is saved and applied the next time you launch the Tops
Import dialog box.

6. Using the Names in row or column and the Depths in row or column (depending
on whether you selected Tops in rows or Tops in columns above), specify the row
or column in which the formation top names and depths appear.

7. In the from and to boxes, specify the range to import.
OR
Drag in the display pane to select the range of tops to import.
Rows are highlighted gray simply to show the columns and rows in which form-
ation top names and depths appear. Rows and columns highlighted green are
those that will be imported into GeoSyn.
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Verify the delimeter GeoSyn chose is correct. GeoSyn attempts to determine the
correct delimeter by reading the source file.

In the Top placement pane, verify the options originally displayed on the Import
Tops dialog box are as desired.

8. Click Apply.

The Select a recipient tops list dialog box appears.

9. Select the list to which to import the tops or click New top list and define a
new tops list, and then click OK. Shift+Click or Ctrl+Click to select more than one
tops list to which to import the list of tops.

Related Topics
"Duplicating tops lists" below
"Managing tops" on page 29

Duplicating tops lists
Duplicate and then customize an entire list of tops or copy only select tops from
one list to another. Tops copied from one list to another don't overwrite tops with
the same name in the recipient list.

Only tops listed in the GeoSyn 2D tops list are available to your model, but you
can copy any tops you want into this list.
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To duplicate tops lists:

1. Right-click a log and select Tops properties.

The Top Properties dialog box opens.

2. In the Tops lists pane, select the tops list to copy then click Duplicate.

To copy only select tops to an existing list instead, in the Tops for list pane,
SHIFT+CLICK or CTRL+CLICK the tops to copy, then click Copy selected
tops to another list to display the Select a recipient tops list dialog box and
select the receiving tops list.

The tops names and depths are copied to a new list that appears below the exist-
ing tops lists in the Tops lists pane.

3. Select the duplicate tops list to display its tops in the Tops for list pane and
select a row that contains a top to change, duplicate, or below which to add a new
row and do one of the following in the boxes below the Tops for list pane:

To change an existing top, type and select the desired details then click Update.
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To make a copy of a top to modify, select the top below which to place the copy
and click Duplicate.

To add a blank row where you can type new top details, select the top below
which to add a blank row, click New, type top details, then click Update.

Related Topics
"Importing tops from delimited files" on page 32
"Importing tops from fixed width files" on page 35
"Managing tops" on page 29
"Importing tops from GeoSyn files" on page 42
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Exporting tops lists
You can save tops lists to disk in ASCII format. The exported file contains form-
ation names, depths, a units flag, and the Kelly Bushing depth. If you select mul-
tiple lists to export, they're written to a single file that you can then edit to
remove duplicate entries.

To export tops lists:

1. Right-click a log and select Tops properties.

The Top Properties dialog box appears.

2. In the Tops lists pane, select the tops list(s) to export to disk and then click
Export. CTRL+CLICK or SHIFT+CLICK for multiple selection.

3. Browse to a disk location in which to save the file, type a file name, and then
click Save.
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The tops are written to the file based on the order in which the tops lists appear in
the Tops lists pane above and in the order in which the individual tops names
appear in each list. Duplicate tops names aren't overwritten.

Related Topics
"Managing tops" on page 29
"Importing tops from delimited files" on page 32
"Importing tops from fixed width files" on page 35
"Importing tops from GeoSyn files" on page 42
"Exporting logs" on page 142
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About Modeling
Seismic reflections occur when there are differences in the seismic wave (P and
S-wave) velocities and the rock densities encountered in the subsurface. The
changes in seismic velocities and rock densities are influenced by changes in litho-
logy, porosity, pore fluid, and subsurface pressures. One of the best ways of inter-
preting seismic amplitudes is to use a seismic model generated from well data.
Using GeoSyn2D, you can generate synthetic seismic models from well data to
visualize the seismic amplitude response to changes in petrophysical rock prop-
erties across reflecting boundaries.

Note:Be aware that there are several factors besides geology that can influ-
ence a seismic amplitudes response when generating and using synthetic seis-
mic models for interpretation. .

Using GeoSyn2D, you can generate numerous synthetic seismic models to help
with seismic amplitude interpretation. A few of these synthetic models are:

l Wedge model—Useful for determining vertical resolution

l 1D Synthetic models based on log data—Involves generating a synthetic
to tie wells to seismic (formation tops to seismic events)

l 2D models—Working with multiple wells simultaneously to visualize and
predict the effect varying rock properties and thicknesses may have on
the seismic amplitude response

Creating AVO logs
Generate AVO logs using either depth or velocity logs. You can use these derived
logs to create crossplots. The derived logs appear in the log display pane with a
Yes under the Derived column.

To create AVO logs using logs:
1. From either the Depth or Tim model, right-click on a log from to derive
the AVO log suite, and selectWell Properties > Log Properties.
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The Well Properties: Log Properties dialog box opens.

2. Select the logs from which to derive the AVO log suite, and then click
Create AVO Logs. The Generate logs for well dialog box will open.

3. Click the individual logs to create, or click Select All, and then click
OK.
To modify the formulas used to derive the Shear Sonic or Density
AVO logs, click Edit to the right of those rows.

Related Topics
"Creating crossplots" below
"Applying math equations to logs" on page 124

Creating crossplots
Create crossplots using data from logs, seismic, and models.

Following are some of the more common crossplots you might create:

offset trace along the x axis and an amplitude trace along the y axis.

© 2020 IHS Markit™. All Rights Reserved 55



About Modeling

incident angle along the x axis and the amplitude from the seismic along the y
axis.

gradient on one axis and intercept on the other.

To create crossplots:

1. From the Edit menu, select Cross Plots ( ).

If there isn't already a crossplot in the main synthetic display, the Crossplot
Wizard: Select Data Type dialog box appears.

Otherwise, the Crossplot Viewer and Crossplot Properties dialog box appears, and
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you must click New to display the above dialog box.

2. Select whether to base the crossplot on time or depth.
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The Crossplot Wizard: Select axis data dialog box appears.

3. Select the logs to plot along first the X axis and then the Y axis.
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The Crossplot Wizard: Set the data range dialog box appears.

4. Click either Select All, or click Define a data range to display the Define
Data Window dialog box where you select the sampling (milliseconds for time
plots and depth samples for depth data), and the overall duration or depth.
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The Crossplot Viewer and Crossplot Properties dialog box appears.

5. Configure display options using the Crossplot Properties: Controls, Crossplot
Properties: X and Y Axis, Crossplot Properties: Enclosures, and Crossplot Prop-
erties: Color Mapping tabs.

Related Topics

"Annotating Crossplots" on the facing
page

"Color mapping crossplots" on
page 62

See Exporting Crossplots, p. 1 "Changing Color Palettes" on page 64

See "Inspecting Logs"
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Annotating Crossplots
Highlight crossplot features by drawing either a polygon or ellipse in the Crossplot
Viewer and then changing the default annotation display properties. The data
points that fall within the polygon you draw are highlighted on the model. This
enables you to see where data points of interest on the crossplot come from. For
details on creating a crossplot, see Related Topics below.

When drawing an ellipse, you can specify an eccentricity of 0 to 0.99 where 0 rep-
resents a circle and 0.99 represents the narrowest (most eccentric) ellipse. Typ-
ing 1 draws a line instead of an ellipse.

To annotate crossplots

1. With at least one crossplot created in the model display, from the Edit menu,
select Crossplot properties ( ).

The Crossplot Viewer and Crossplot Properties: Enclosures dialog box appears.

2. Click the Enclosures tab.
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3. Do one of the following:

l To draw a polygon, click Start, and then click to define the anchor
points for the polygon segments in the Crossplot Viewer. Click End to
complete and automatically enclose the polygon.

l To draw an ellipse, type a decimal value from 0 to 0.99 in the eccent-
ricity box. Click Start and then click to anchor one end of the ellipse.
Move your mouse across from the start anchor point to the desired end
point and then click to anchor that point.

As you draw polygons and ellipses, they're added to the Enclosure list below
the drawing controls. Draw multiple annotations to encompass different fea-
tures.

4. In the Enclosure List, select the annotation with which to work .

In the Name box, type a descriptive name for the annotation(s) selected above.

5. Select from the following display properties:

l Outline to specify the annotation border color.

l Infill to specify the annotation fill color within the annotation border.

l Both to select one color for both the annotation border and fill.

6. In the Link List pane, click the synthetic or log on which to display the data
point highlighting.

To hide an annotation from the Crossplot Viewer, clear the check box in the Show
column of the Enclosure list. You can also select the enclosure and then press
Delete.

Related topics
"Creating crossplots" on page 55
"Color mapping crossplots" below

Color mapping crossplots
Select areas of the crossplot to color. Either work with a color gradient to change
the default palette or use a block fill to change the color of desired cells on the
grid. The color you apply is also displayed for the data points on the log or syn-
thetic that also fall within that cell.
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This functionality is similar to drawing annotations that encompass desired data
points. For details, seeRelated Topics below.

To color map crossplots:
1. Open theCrossplot Properties: Color Mapping dialog box:

l From the menu, Edit>Crossplot properties

l From the tool bar, click on the main toolbar

2. Click the Color Mapping tab.

3. Select either of the following:

l Gradational, to apply a color to one of the four quadrants that blends
with the colors from the surrounding three quadrants.

l Blocked, to fill individual cells you click with a solid color. In the
Columns and Rows boxes, type the number of segments into which to
divide the overall Crossplot Viewer canvas size. For example, if you
type 2 in both boxes, the Crossplot viewer canvas is divided into four
quadrants. If you type 100 in both boxes, the Crossplot viewer canvas
is divided into a 100 x 100 grid.

4. Click Brush to select the desired color.

5. In the Link List pane, click the synthetic or log on which to display the
data point highlighting.

Note: To hide color coding from the Crossplot Viewer, clear the Enable
color coding check box.

Related Topics
"Creating crossplots" on page 55
"Annotating Crossplots" on page 61
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Changing Color Palettes
Specify color fills for logs and traces in seismic, logs, cross plots, models, and
more using the Color Palette dialog box. Color schemes can be loaded from stock
color palettes that ship with GeoSyn, or from color templates you save in the
GeoSynWorking directory with a .pal extension. Templates can be quickly
applied to any synthetic and can be shared amongst GeoSyn users.

Color schemes can also be configured for the current synthetic without creating a
template and can be automatically saved with individual GeoSyn files.

To automatically apply a color scheme to all new synthetics, apply it to the cur-
rent synthetic then update the import defaults file with the current synthetic
options. For details, see Related Topics below.

When working with models and certain types of crossplots, you can drag the min
max color nodes that appear at the top and bottom of the histogram to tighten
them to the desired amplitude range so that a fuller color spectrum is displayed in
GeoSyn. This option isn't available for cross plot properties with a depth-based
color reference type, or for logs, as typically a certain color represents a certain
log value and is related to lithology.

To change color palettes:
1. Open the Edit color palette:

l Well Properties: Log Properties, select Edit adjacent to the Infill
display ().

l Model Properties dialog box, select Edit adjacent to the color dis-
play ().

l Seismic Properties dialog box, select Edit adjacent to the Color
underlay display ().

The Edit color palette dialog box appears. The top and bottom of the color bar rep-
resent the fixed extremes in the data values of the selected log or trace. Nodes
along the display bar associate a color to a particular data value.
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2. Choose a palette:

l Copy a stock palette drop-down list

l Load import a previously saved custom palette .

l None remove all colors

To create a custom color palette:
1. Creating a custom color bar can be done in several ways:

l Drag and drop color on existing node.

l Drag and drop color on the color bar. GeoSyn creates a corresponding
node for each color you drop.

l Create a custom color
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2. Type a unique name for this color configuration in the Palette Name
box then click Save to save it in the GeoSynWorking directory.

Related topics
"Changing log display properties" on page 106
"Creating crossplots" on page 55
"Changing import defaults" on page 13
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Changing model porosity
Porosity is modeled by changing a well logs density and or velocity.

l Sonic porosity( ) is calculated using one of three selectable equations:

Wyllies time
average

Velocity average

Raymers etal

( ) mineral matrix, ( ) pore fluid

l Density porosity ( ) is calculated as a simple volumetric average of
the densities.

( ) mineral matrix, ( ) pore fluid

Note: Mineral matrix velocities are calculated internally by solving the velo-
city equation for mineral velocity followed by plugging in the VP and
fluid velocities. Once mineral matrix velocities are known then the
equation is reset to solve for Vp and porosity may be adjusted,
which changes VP.

Below is an example of changing the porosity from 13% to 30% using the model
porosity tool.
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Insitu porosity = 13% Model porosity = 30%

To model the porosity of a log

Modify the percentage of porosity to a selected portion of a log using the Log
Editor.

1. Open the Log Editor.

2. Click the Model porosity tool ( ) on the Log Editor toolbar to
open the Model Porosity dialog.
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3. Enter the logs Insitu porosity value and click Update. This creates a
starting point for the porosity model.

4. Select a value for the fluid property from the drop down list.

5. Select a P Sonic and or Density log.

6. Select a velocity equation to apply to the model. See equations above.

7. Set the depth range. Once set, the number of samples and a meas-
urement for the selected depth range will be updated on the dialog. The
depth range will also be highlighted in on the log in cyan . The depth
range is set using one of four methods:

l Click and drag the Log editor cursor to select a depth range.

l Type values in the depth fields and click Update

l Click Top or Bottom to accept the absolute depth from the log or
click All to accept both

l Click Depths from tops to display and select formation tops
that signify your zone of interest from a drop-down lists .

8. Use slider to change percentage of porosity. Changes made will be
reflected on the selected Sonic and density logs.

9. Click Close to apply changes or Cancel to discard changes.

Related Topics
Model porosity dialog
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About Time Models
The time model is a series of one-dimensional synthetics calculated at constant
intervals across the depth model. The time model makes no attempt to model dif-
fraction effects, and in essence represents a perfectly migrated seismic section.

GeoSyn only generates a time model after you create a correlation that hori-
zontally spans the entire depth page. After GeoSyn generates the time model,
the Time page button ( ) in the main toolbar is active.

Using GeoSyn's porthole functionality, capture portions of the synthetic in a sep-
arate window in which you change the frequency and other wavelet properties to
view different scenarios, such as what strength of source signal will be required in
order to clearly see a play.

Create an entire suite of logs that can be used for AVO analysis using reflection
coefficients. Instead of creating each type of log individually, one selection from
the Reflection Coefficients drop-down list enables you to create them with a
single click.

Changing time models
Change the dimensions and display properties of the time model and also the dis-
play properties of synthetic traces themselves.

Create multi-offset models for amplitude offset analysis. If summing traces, you
can define groups of traces (near, middle, far) and then using mathematical oper-
ations between the three groups, filter or enhance certain portions of the offset
trace. For example, you might subtract the far traces from the near traces and
then multiply the difference by the far traces to enhance the far offset amplitude.

To change time models:

1. Open the Display Parameters: Time Model dialog box:

l From the main menu: Edit > Display Parameters...

l From the toolbar click ( )

l Double-click on the time model.
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The Display Parameters dialog box opens on the Display tab.

2. Set all display configuration options for your model.

3. Click the Parameters tab and select any options required.

4. If generating a multi offset model, click the Multi Offset tab and select
any options required.
If any of the curves required for multi-offset modeling are missing,
GeoSyn prompts you to generate them.

5. Click Update All to accept changes.

Related Topics
"About Time Models" on the previous page
"Changing depth models" on page 91
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Displaying images and annotations
GeoSyn enables you to create text annotations and import or select stock images
to display in either the depth or time pages. You control the display options of all
annotations and images from a single dialog box.

A metafile image pasted into your Windows Clipboard in another application by
pressing ALT+PRINT SCRN can be pasted into GeoSyn. For example, you could
paste a surface map into your Windows Clipboard and then paste this into
GeoSyn.

The image or annotation is displayed in either the depth or time page depending
from which you launched the Edit Labels dialog box.

Separate procedures for importing images and annotations appear below.

To import images
1. Open the Edit labels dialog:

l Menu: Edit > Labels

l Toolbar: Click ( )
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The Edit Labels dialog box opens.

2. Click Import and browse to the location where the .emf file to import
is located, select the file, and then click Open.

3. Select either an anchor point or Floating from the Linkage drop-down
list then click Update.

4. Click Duplicate to create a copy of the selected image that you can
anchor to a different location.

To create annotations or select stock symbols
1. Open the Edit labels dialog:

l Menu: Edit > Labels

l Toolbar: Click ( )

The Edit Labels dialog box opens

2. Click either Text or Symbol and depending on your selection, do one
of the following:
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l For annotations, type the text to display in the Text box and select link-
age options, then in the Display pane select font, color, and text box dis-
play options.

l For symbols, select the type from the Symbol drop-down list and linkage
options, then in the Display pane select size, color, and border options.

Related Topics
"Main display" on page 1
"Changing global properties" on page 4

Zooming
You can draw the boundary upon which to zoom in the main display.

To zoom:
1. From the Viewmenu, select Zoom In ( ).

The cursor changes to a magnifying glass ( ).

2. Click and hold one of the corners that will become your zoom extents
then drag the zoom rectangle to the opposite corner of your zoom
extents and release the mouse button.

3. Either repeat the above steps to zoom in further or from the View
menu, select Zoom Out ( ) to return to the previous view. If you've
zoomed in multiple times, each time you zoom out returns to only the
previous view. To return to the original unzoomed view, and provided
the last step you did was zoom in, from the Edit menu, select Undo (
).

Related Topics
"Main display" on page 1
"Changing global properties" on page 4

Displaying multiple views of individually filtered
time sections
You can use the Port Hole window to capture portions of the time model at dif-
ferent frequencies to determine what frequency and source parameters you'll
need in order to see a play.
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You can display multiple Port Hole windows containing the same time model por-
tion at different frequencies alongside each other for comparison.

To displaymultiple views of individually filtered time sections:
1. Zoom into the portion of the time model you want to capture. For
details, see Related Topics below. You can also resize the Port Hole win-
dow so your zoommeasurements don't have to be exact.

2. From the Viewmenu, select Port Hole ( ).

The Port Hole window appears.

3. Drag the Port Hole window over the portion of the time model to cap-
ture and resize the Port Hole window to contain the portion of the syn-
thetic to capture by dragging the Port Hole window borders.

4. Click Set Filter.
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The Wavelet dialog box opens.

5. Change the frequency settings and then click Close to return to the
time model page. For details about setting wavelet properties, see
Related Topics below.

6. Click Grab.

7. Drag the Port Hole window to any location on the time page.

To capture additional samples at different frequencies for comparison, repeat
from step 2 above.

Related Topics
"Zooming" on page 105
"Changing wavelet properties " on page 83
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Working with Wavelets
A seismic wavelet is an approximation of the pulse generated by a source (dynam-
ite, pulse, etc.) as it appears at the given depth and after it has been processed.
To generate a synthetic, you must provide a velocity curve and a wavelet. The
wavelet is extracted from the seismic data or from standard theoretical wavelets
(Ormsby, O'Brien, Klauder, Butterworth, Minimum Phase, Gaussian, or Ricker).
The wavelet is then convolved with the reflection series to produce the synthetic.

Related topics:
"Importing wavelets and sets" below
"Changing wavelet properties " on page 83
"Extracting wavelets" on page 84
"Exporting wavelets and sets" on page 144

Importing wavelets and sets
Import wavelets in ASCII or SEGY format and import wavelet sets in .wav format.
Wavelets can be saved and imported using a centralized library of wavelets you
create. The wavelet library is accessed by all GeoSyn projects.

To avoid aliasing, GeoSyn doesn't extract frequency information higher than the
Nyquist frequency of either the import data or the current model, whichever is
lowest.

Separate procedures for importing wavelets and wavelet sets appear below.

To import wavelets:
1. From the Edit menu, selectWavelet properties ( ).
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The Wavelet Properties dialog box appears.

2. In the Import/Export pane, click Import to the right of the wavelet label to
import a wavelet from disk. Alternately, import wavelets from a centralized wave-
let library used by all GeoSyn models by clicking Retrieveto the right of the
Library label to display the Wavelet Library dialog box, where you select the wave-
let and then click Import wavelet; otherwise, continue with the steps below.

The Import time data dialog box appears.

3. In the Files of type drop-down list, select whether to import SEGY or ASCII
data then browse to and select the file.
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If you select a SEGY file, the Import Wavelet Processing Flow dialog box appears;
otherwise, if you select ASCII, the Highlight First Line dialog box appears.

4. Select the first line to import then click Next.

The Highlight Last Line dialog box appears.

5. Select the last line to import the click Next.
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The Set Column Delimeters dialog box appears.

6. Set the column delimeters ( ) by clicking in the display pane between required
columns. The green line can't bisect a data column. Double-click column delim-
iters to delete.

7. Click the box that appears below each delimeter to display the Select from List
dialog box and identify the data type.

8. Click Next.
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The Finish dialog box appears.

8. Click Back to change any previous selections or click Finish.

The Import Wavelet Processing Flow dialog box appears.

9. Specify whether to taper the file on import, the name by which to identify the
wavelet, the length of the operator, and then click OK.

To import wavelet sets

1. From the Edit menu, selectWavelet properties ( )
OR
Right-click a wavelet and selectWavelet properties from the popup menu.
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The Wavelet Properties: Wavelet dialog box appears.

2. In the Import/Export pane, click Import to the right of theWavelet Sets
label. Alternately, import wavelets from a centralized wavelet library used by all
GeoSyn models by clicking Retrieveto the right of the Library label to display the
Wavelet Library dialog box, where you select the wavelet and then click Import
wavelet; otherwise, continue with the below steps.

The Import a wavelet set dialog box appears.

3. Browse to and select the wavelet file in .wav format then click OK.

The Import Wavelet Groups fromWavelet Set dialog box appears.

4. Select the wavelet group(s) to import then click OK.

Related Topics
"Changing wavelet properties " on the facing page
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Changing wavelet properties
Apply up to three filters to different segments of a model and specify the amount
of overlap between filters.

To change wavelet properties:
1. Open the TheWavelet dialog box :

l Menu: Edit > Wavelet

l From the toolbar click

2. From the Aux. trace drop-down list, select whether to display a back-
ground trace to which to correlate the displayed trace

3. From the Background drop-down list, select whether to display a dif-
ferent color scheme.

4. Type a value in the center phase box or drag the slider below it.

5. Type a length for the operator, which controls the sample size dis-
played in the window.
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6. To customize the amplitude or phase spectrum of the selected wave-
let, click the Spectrums tab.

The Spectrums tab appears.

6. Hover your cursor over the amplitude display then click to define points that
describe the modified spectrum.

7. Click either Amp or Phase to apply the defined points to either, or click Clear
(or press ESC) to exit drawing mode without applying changes.

8. Click the horizontal arrows at the bottom of the view window to change the
amount of frequency shown.

9. Click theWavelet tab to review how the changes will appear then click Close
to apply them to the main display.

Related Topics
"Extracting wavelets" below
"Importing wavelets and sets" on page 77

Extracting wavelets
Traces are extracted into zero-phase wavelets using the following process:

During extraction, all import traces are summed and the resulting trace tapered.

Next the import trace is auto-correlated and an operator is extracted from the
center. This is likely a non-zero operator at the operator extremities and must
therefore also be tapered using either Cosine, Hanning, or Cosine Squared
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methods. The longer the extracted operator, the more detailed the extraction.
You may want to extract the wavelet using long operators (high detail), then
shorten the wavelet length after to avoid damaging the amplitude spectrum
detail. GeoSyn saves only the amplitude and phase spectrums and calculates
time wavelets when required.

Lastly, an amplitude spectrum is calculated from the extracted, tapered wavelet.
The phase spectrum is set to zero.

To extract wavelets:
1. From the Edit menu, selectWavelet ( ).

The Wavelet dialog box appears.

2. Beside the Extractionlabel, click Extract.

The Import time data dialog box appears.

3. Select the SEGY file with data upon which to base the extracted wavelet then
click Open.
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The Zero Phase Extraction Processing Flow dialog box appears.

4. Specify the time range and number of traces to sum, the method by which to
sum the traces, the length of operator to derive from the summed traces, and the
method by which to taper the operator, and then click OK.

The extracted wavelet appears in theWavelet Properties dialog box.

Related Topics
"Changing wavelet properties " on page 83
"Importing wavelets and sets" on page 77

Exporting wavelets and sets
You can export individual wavelets in ASCII or SEGY format, or export multiple
wavelets bundled as a wavelet set in .wav format. Wavelets can be saved and
imported using a centralized library of wavelets you create. The wavelet library is
accessed by all GeoSyn projects.

For details on extracting a zero phase wavelet, see Related Topics below.

To export wavelets:
1. From the Edit menu, selectWavelet ( ).
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The Wavelet Properties dialog box appears.

2. In the Selected wavelet attributes pane, besideWavelet, click Export, or
click Add to the right of the Library label to add the wavelet to the centralized
Wavelet Library shared by all GeoSyn models.

3. Browse to a disk location in which to save the file then click Save.

Related Topics
"Extracting wavelets" on page 84
"Exporting time data" on page 141
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About depth models
A depth model consists of a minimum of two zones, which are closed polygons.
You generate zones by either drawing correlations with your mouse, or by using
the Create Well Correlations dialog box.

Zones encapsulate velocity fields, which may be generated by interpolating or
extrapolating impedance data from wells that intercept a zone, or with a constant
impedance value you define. Once zones are created, you can view the resulting
time model. You modify zones, correlation nodes, and log readings on the depth
page to influence the time model.

Any number of logs can be included in a model, but GeoSyn only uses a single
sonic and a single density from each well to create the time model. These logs are
called the active sonic and active density. You can select any two logs in each
well as active, which enables you to quickly shift between logs that represent dif-
ferent geological scenarios.

Changing well display properties
Change general properties that apply to all wells, including scale annotations and
model trimming, or specific properties that apply to individual wells, including well
labels, KB elevations, depth increments, and more.

Drag a well anywhere on the cross section before drawing correlations. After
you've drawn correlations, it's more difficult to drag wells because GeoSyn
doesn't allow you to move a well across an existing correlation node. If you must
cross a correlation when dragging a well, using the Display Parameters: Wells dia-
log box, duplicate the well then click the cross section in the desired location to
place it, and then delete the old well.

To adjust global well display properties:

1. From the Edit menu, select Display Parameters ( ) >Wells.
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The Display Parameters: Wells dialog box appears.

2. CTRL+CLICK or SHIFT+CLICK the wells to modify in the Well list
pane.
Only options that can be applied to multiple wells remain active in the
dialog box.

3. Select the display options to apply to the selected wells then click
Close.

To adjust single well display properties
1. In the depth model, right-click a well and selectWell properties.
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The Well Properties: Well properties dialog box opens.

2. Select the desired options then click Close.

Related Topics
"Editing correlations" on page 98
"Changing deviated well properties" on page 28
"Trimming models" on page 104
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Changing depth models
Set depth model properties including the overall size of the canvas, the depth
increment with which to resample the impedance field, properties for scales,
traces, correlations, and correlation nodes.

To change depth models:

1. From the Edit menu, select Display parameters ( ).

The Display Parameters: Depth Model dialog box appears.

2. To change the size of the main display, you can either drag and drop
the canvas borders, type different dimensions above, click Trim and
type a start or stop depth, or type a different display range above. Trim-
ming the model deletes well and correlation data with which the new
model borders intersect, while resizing the display simply moves the
canvas borders without affecting the underlying data. For details, see
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Related Topics below.

3. Select a tab to configure and select Show page so that the tab also
appears as a tab in the main window. To copy elements from one tab to
another, select the elements from the Select a copy option drop-
down list and then click Copy. Note that this can be used to update the
existing tab with settings from another or to replicate settings from the
current tab to another.

4. Select the options to define a geologic scenario, and then click Update
All.

Related topics
"Trimming models" on page 104
"Creating correlations" on page 94
"Changing log display properties" on page 106
"Changing time models" on page 70
"Configuring Zones" on page 100
"Changing well display properties" on page 88
"Printing models" on page 140

Displaying images and annotations
GeoSyn enables you to create text annotations and import or select stock images
to display in either the depth or time pages. You control the display options of all
annotations and images from a single dialog box.

A metafile image pasted into your Windows Clipboard in another application by
pressing ALT+PRINT SCRN can be pasted into GeoSyn. For example, you could
paste a surface map into your Windows Clipboard and then paste this into
GeoSyn.

The image or annotation is displayed in either the depth or time page depending
from which you launched the Edit Labels dialog box.

Separate procedures for importing images and annotations appear below.

To import images
1. Open the Edit labels dialog:

92 © 2020 IHS Markit™. All Rights Reserved



Changing depth models

l Menu: Edit > Labels

l Toolbar: Click ( )

The Edit Labels dialog box opens.

2. Click Import and browse to the location where the .emf file to import
is located, select the file, and then click Open.

3. Select either an anchor point or Floating from the Linkage drop-down
list then click Update.

4. Click Duplicate to create a copy of the selected image that you can
anchor to a different location.

To create annotations or select stock symbols
1. Open the Edit labels dialog:

l Menu: Edit > Labels

l Toolbar: Click ( )

The Edit Labels dialog box opens
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2. Click either Text or Symbol and depending on your selection, do one
of the following:

l For annotations, type the text to display in the Text box and select link-
age options, then in the Display pane select font, color, and text box dis-
play options.

l For symbols, select the type from the Symbol drop-down list and linkage
options, then in the Display pane select size, color, and border options.

Related Topics
"Main display" on page 1
"Changing global properties" on page 4

Creating correlations
After importing wells into your depth page, you draw correlations either using
your mouse, the Create Well Correlations dialog box, or the Correlation Wizard.
Correlations are used to establish the boundaries of zones, and zones encap-
sulate velocity fields. For details about zones, see Related Topics below.

Draw correlations that span the entire cross section and that replicate horizons,
or draw correlations to replicate geological anomalies such as inter-well chan-
nels.

The border of the depth page canvas is one large correlation and the outside bor-
der of each well another. Crossing these objects with a correlation line auto-
matically latches the correlation line to the canvas or the well border. Crossing an
existing correlation line while drawing a new correlation line latches the new cor-
relation line to the existing one and ends the current correlation.

GeoSyn can't generate a time model without at least one correlation that hori-
zontally spans the entire depth page canvas creating an upper zone and a lower
zone.

Before creating correlations, from the Edit menu, select Display Parameters (
) and ensure that Color Underlay is selected, but that Range Auto is

cleared.

To create a correlation using the Create Well Correlations dialog box:

Using the Create Well Correlations or Correlation Wizard dialog boxes enables
you to latch correlations more accurately than using your mouse.
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If a well doesn't have any tops, GeoSyn prompts you to populate the well's empty
top list with tops from another well. The Populate Empty Top Lists dialog box
appears. Select the well with the tops with which to populate wells without tops,
and then click OK.

1. From the Edit menu, select Correlate Wells ( ).

The Create Well Correlations dialog box opens.

2. Do any of the following:

To create a new correlation, click Start in the Create Well Correlations toolbar.
Working from left to right, click the top to which to latch the correlation within the
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desired wells. You don't have to include each well in your correlation.
The correlation automatically ends after you click the last well. To end a cor-
relation without latching it to the right-most well, in the Create Well Correlations
toolbar, click End.

To change the top properties, right-click the top name and select Edit top N,
where N is the name of the top to edit, and then change the top properties in the
Top Properties dialog box (for details, see Related Topics below).

Each correlation takes its name from the left-most top in the correlation.

To create a correlation using the Correlation wizard:

1. From the Edit menu, select Correlate Wells ( ).

The Create Well Correlations dialog box appears.

2. In the toolbar beside the Create Well Correlations dialog box, click Auto Cor
Wizard.
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The Auto-Correlation Wizard dialog box appears.

3. Specify the criteria by which to link correlations then click Next.

GeoSyn displays the number of complete and partial correlations.

Click Back to select further criteria in the Correlation Wizard dialog box above, or
click Apply to create the correlations.

Each correlation takes its name from the left-most top in the correlation.

If your model becomes corrupted, launching the Correlation Wizard and then clos-
ing it without applying any correlation changes will correct it, although you'll have
to recreate any inter-well nodes.

To create a correlation using the mouse

Although you can create correlations without a well in the depth model, you'll typ-
ically create correlations using only your mouse when drawing geologic anom-
alies such as channels.

1. From the Edit menu, select New Correlation ( ).

The Create a New Correlation dialog box appears.
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2. Type a name for the correlation or accept the automatically generated number
and then click OK.

3. Click to the left of the left-most vertical scale to establish the start of the cor-
relation then click the right-most border of the first well to latch the correlation to
this well.

A new top with the same name as the correlation you specified above appears in
the well. This top is also created in the GeoSyn 2D Tops list.

4. Click to the right of each remaining well to latch the correlation at the desired
depth then click to the right of the right-most vertical scale to create a correlation
that horizontally spans the entire depth model. You can't skip over a well when
correlating.

To create a partial correlation that doesn't span the entire depth model, after
clicking to establish the final node, either press ESC, or cross the current cor-
relation line over itself by dragging the cursor left of the last node you estab-
lished and click. Also note though that correlations that don't horizontally
span the entire cross section and don't cross over themselves to encapsulate
a velocity field don't affect the time model.
To tie the current correlation to an existing correlation, cross the new cor-
relation line over the existing correlation line and click.

Two zones are automatically created on either side of the correlation line you
drew.

Related Topics

"Editing correlations" below "Configuring Zones" on page 100

"Changing tops properties" on page 31

Editing correlations
You access most correlation editing functionality by right-clicking a correlation on
the depth page.

To edit correlations:

Right-click the correlation to modify and select from the following:
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l Edit correlation, to display the Edit Correlations/Nodes dialog box and
specify the name and display style of the correlation and depth of nodes
along it.

l Delete to remove the entire correlation. To restore a deleted correlation
recently after deleting it, select Edit > Undo > Delete a correlation.

l Break to display the Break Old Correlation, Rename New Correlations
dialog box and type names by which to identify the segments left and
right of the break. The break occurs where you right-clicked the seg-
ment. Segments keep the names you type here even after they're
attached to a different segment or reconnected.
If the correlation you break defines a zone, the zone is deleted.

l Extend to change your cursor to a cross-hair ( ) with which you click
to define nodes. If neither end of the correlation are latched to a well or
to the models vertical scale, a dialog prompts you whether to extend the
left or right node.
You can continue to create nodes until your cursor crosses either an exist-
ing correlation or the vertical scale of the depth model. In both cases the
correlation will latch and if possible, create a zone.
You can reconnect broken nodes by either selecting Extend or by simply
dragging the node nearest the break over an existing correlation so it
latches.

l Add a node, to place a node on the location you right-clicked. Adding
nodes enables you to increase precision when defining geological anom-
alies.

Related Topics
"Configuring Zones" on the next page
"Changing tops properties" on page 31
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Configuring Zones
A zone is a closed polygon with the physical dimensions of depth vs. offset
between two correlated wells. The impedance characteristics of the zone depend
on whether that zone intersects a well bore. If it does, the impedance char-
acteristics are the interpolated velocity and density logs. If it doesn't, such as an
inter-well channel, the impedance characteristics are a static (blocked) velocity
and density value. The boundaries of zones are highlighted yellow when you
hover the mouse over one in the main interface. The sub-zones are highlighted
blue.

When GeoSyn is first launched you see a blank page. A minimum of one cor-
relation, running from one side of the model to the other is required to create the
minimum two zones necessary to create a valid model. A model can be comprised
of any number of complete zones and sub-zones.

Within the zone (the polygon that runs the entire length of multiple correlated
wells) are sub-zones, which exist between each well. While the boundaries of
zones are highlighted yellow when the mouse is hovered over them, the bound-
aries of sub-zones are highlighted blue. The interpolation of zones and sub-zones
can be configured separately. Sub-zones allow for more granular interpretation.

To configure zones:

1. After creating a correlation (for details, see Related Topics below), from the
Edit menu, select Zones ( )
OR
Right-click a zone and select either Zone Interpolation or Sub-zone Inter-
polation from the context menu.
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The Edit Zone Parameters dialog box appears.

2. In the zone list, select the zone with which to work. As you select a number,
the corresponding zone is highlighted on the depth page.

Overlapping zones can corrupt your GeoSyn model. A quick way to locate corrupt
zones is to display the Edit Zone Parameters dialog box and select each zone num-
ber in the zone list (or click each zone on the depth page) to verify it is high-
lighted on both the depth page and in the zone list. Any zones that aren't
highlighted can be deleted on the depth page.

3. For zones that intersect a well bore, select whether the zone impedance should
be interpolated from the bottom of the zone upwards (to simulate offlap), from
the top of the zone downwards (to simulate onlap), or by stretching and squeez-
ing (to simulate compaction). Note that onlap and offlap are loosely applied strati-
graphic definitions which won't hold true in situations where there are over-
turned beds.

You can apply the same impedance characteristics to all zones in the model
by clicking one of the buttons in the Set all pane.
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4. Select whether to fill the zone with a specific lithology and whether to display
that lithology on the depth page. To change the display color of any lithology
throughout this and future models, click Edit to display the Edit Lithology dialog
box.

5. Select whether arrows appear on the depth page indicating the direction of
interpolation and whether to use interpolation algorithm 1 (recommended) or 2
(thinning zone with a large horizontal impedance gradient). Click Interpolation
Method for a sample of how the two methods interpolate zones differently.

Related Topics

"Creating correlations" on page 94
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Flattening correlations
You can flatten either the depth model or the time model along any correlation
that spans the entire cross section. Being able to flatten along a correlation that
represents an established time marker or a formation with which you're familiar
enables you to see how the flattened formation, and those below it, looked when
the formation was initially deposited.

You can draw channels along a flattened formation and then remove flattening to
see what effect time and deposition has had on adjacent formations on the depth
page and on synthetic traces on the time page. When you flatten or remove flat-
tening on a correlation, GeoSyn automatically inserts inflection points into cor-
relations above and below the correlation you changed so you can easily
determine impact. These inflection points are automatically removed when you
remove flattening.

You can flatten on different horizons on the depth page and the time page. Flat-
tening on one page has no effect on the other.

When flattening on the time page, GeoSyn interpolates the velocity field above
the wells by extending the last few values on each log. You can flatten on an
upper-horizon to tame the variable velocity field, which looks like an ocean wave
and is caused by the above interpolation.

To flatten correlations:

With a correlation that horizontally spans the entire cross section, in either the
depth page or the time page, right-click the correlation and select Flatten N
from the shortcut menu, where N is the name you assigned to the correlation
when creating it.

For details on drawing channels using correlations, see Related Topics below.

Note: To remove flattening, right-click the correlation and select Remove
flattening.

Related Topics
"Creating correlations" on page 94
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Trimming models
Change the depth range of the depth model by using the Display Parameters:
Depth Model dialog box and either typing a new depth range in the Dimensions
area, or by clicking Trim Model. While clicking Trim Model automatically deletes
all correlations, nodes, and well data outside of the trim range, typing new dimen-
sions won't reduce the model depth range if it entails deleting data.

Instead of trimming the depth model, reduce the portion of the depth model
that's displayed by typing values in the Display Range pane of the Display Para-
meters: Depth Model dialog box. Changing the display range doesn't delete any-
thing, it merely hides the top or bottom of the model. You can also change the
display range by hovering your mouse over the top or bottom canvas border until
the cursor changes to a cross hair ( ), and then dragging the canvas border.

If trimming by subsea values instead of by correlation marker, ensure you
remove flattening from your cross section because the Trim Depth Model dia-
log box trims using true subsea values while flattening references the cor-
relation upon which you flatten as zero.

To trim models:
1. Right click the correlation above or below which to trim and from the
shortcut menu, select Trim model above correlation or Trim
model below correlation.

The Trim Depth Model dialog box opens.

2. Select whether to trim based on a specific correlation or by subsea
depth, and the amount of buffer to leave between the trim line and the
correlation, and then click OK.
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Related Topics
"Creating correlations" on page 94
"Cutting logs" on page 128

Zooming
You can draw the boundary upon which to zoom in the main display.

To zoom:
1. From the Viewmenu, select Zoom In ( ).

The cursor changes to a magnifying glass ( ).

2. Click and hold one of the corners that will become your zoom extents
then drag the zoom rectangle to the opposite corner of your zoom
extents and release the mouse button.

3. Either repeat the above steps to zoom in further or from the View
menu, select Zoom Out ( ) to return to the previous view. If you've
zoomed in multiple times, each time you zoom out returns to only the
previous view. To return to the original unzoomed view, and provided
the last step you did was zoom in, from the Edit menu, select Undo (
).

Related Topics
"Main display" on page 1
"Changing global properties" on page 4

Changing log definitions
GeoSyn maintains a centralized database file of log definitions
(LogInit50.gld)where you can customize settings such as:

l Track widths

l Scales

l Aliases

l Color fills

l Several others
Settings are applied only to new models whose log settings have not already
been defined in the import defaults file.
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To change log defaults:
1. Open the Properties: Log Definitions dialog box Edit > Configuration
properties > Log Library.

2. In the tree displayed, click the plus sign (+) beside the appropriate
node to expand it and view current configuration details.

3. Click Edit curve to open the Edit Default Display Properties dialog box

4. Configure the curve properties then click OK to return to the Prop-
erties: Log Definitions tab.

5. Click Close to return to the main display. The changes you made are
applied to future models providing a different setting doesn't exist in
the import defaults file for that model.

Import defaults file
The import defaults file usually contains all default settings except those that
apply to logs. When you update the import defaults file with settings from the cur-
rent model, settings for log types in the current model are also written to it. Log
settings in the import defaults file override, but don't overwrite settings in the log
definitions database.

When GeoSyn creates a model, it first checks whether display settings for the
logs upon which the model will be based exist in the current import defaults file. If
they do, GeoSyn uses them instead of the settings in the log database.

Related Topics
"Changing import defaults" on page 13
"Changing log display properties" below

Changing log display properties
Change the display properties of logs in the current model including label inform-
ation, which logs are the active sonic and density, and other details. The term Act-
ive denotes the log upon which the model is based. If you have several sonic logs
with different geological scenarios in one model, for example, you can switch
which of the sonic logs is the active one to see what affect it has on the model.

Create new logs or duplicate logs and modify existing logs. These changes affect
only the current model, not log defaults for new models. For details on changing
log defaults and import defaults, see Related Topics below.
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To change log display properties:
1. In the depth page, right-click the log to modify and select Log prop-
erties from the shortcut menu.

The Well Properties: Log properties dialog box appears.

2. In the display pane, select the log(s) to modify using the controls
below. SHIFT+CLICK or CTRL+CLICK for multiple selection.
You can duplicate and modify selected logs, and also clear logs in the
Show column to save them with the model but hide them from the main
display.

3. In the Properties common to all logs pane, specify label and scale
information. Although the One log/track option appears, you can't
select it.

4. In the Log properties pane, specify log associations such as the type
of log, whether it's the active sonic or density, and whether it meas-
ures transit time or velocity, and then click Close.

Related topics
"Changing log definitions" on page 105
"Changing import defaults" on page 13
"Changing Color Palettes" on page 64
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"Combining logs in tracks" on the facing page
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Combining logs in tracks
Logs can occupy either separate tracks in the main display or can share tracks to
save work space. GeoSyn enables you to specify the logs to display in up to ten
tracks and displays an unlimited number of logs in any track. The same log can be
repeated in multiple tracks.

With a left and right log defined in the same track, select cross over options and
adjust the horizontal placement of the logs to infill areas where the two logs over-
lap.

Save composite log layouts with different configurations as templates with a .tpl
extension in the GeoSynWorking directory.

To combine logs in tracks:
1. In the depth page, right-click the log to modify and select Log prop-
erties from the shortcut menu.

The Well Properties: Log properties dialog box appears.

2. In the Properties common to all logs pane to the bottom right of the dia-
log, beside the Multiple logs / track option, click Edit.
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The Multi-Log per Track Template dialog box appears.

3. For the Populate tracks radio buttons, select either automatically by
type (sonic, density, etc), ormanually by name (Delta-T, Bulk Dens-
ity, etc.) depending on the degree of control you want over which logs
appear, and then click Edit.

110 © 2020 IHS Markit™. All Rights Reserved



Combining logs in tracks

The Multi-log per track layout dialog box appears.

4. For each of the track columns, click the log type to display, and then
click OK.

Note: To ensure a log doesn't get dropped, click the All unselected linear logs
and the All unselected logarithmic logs options.

The log types selected above are displayed in the various track tabs of the main
Multi-log per Track Edit dialog box.

5. Using the Multi-log per Track Edit dialog box, for the tracks to display,
click the Track tab, specify whether to show the track and select other
criteria such as the track width, scale type, and so on.

6. In the log display pane click or clear Show as depicted below to display
or hide a log in a given track.
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The Tracks column above displays the tracks in which a log appears. In the
example above, the density log can be displayed in track 1. It also appears
in track 3. The column to the right of the Log name column specifies whether
the log appears in a track by default or was deliberately designated to
appear in that track.

To fill areas where curve readings for two or four curves intersect within the
same track, select the check box to the left of the drop-down lists in the
Cross overs section and then select either logs that appears in your model
or select fixed value depending on whether you want to infill where curves
intersect, or where a curve exceeds a given value. Manually shift a curve by
clicking to the right of the curve drop-down list to enhance the cross
over, or type a percentage by which to shift the log scales.

7. Type a descriptive name in the Template name box and click Save to
write the file to the current GeoSynWorking directory with the name
GSTemplateX.tpl where X is an incrementing number based on the num-
ber of template files already in theWorking directory. When importing
the template file in the future, whatever is typed in the Template
name box appears as the file description.

8. Click Apply to update the current model with your changes.

Related Topics
"Changing log display properties" on page 106

Exporting logs
Well logs can be exported in LAS format to use with other geologic applications as
well as GeoSyn, or exported to GeoSyn format to use only with GeoSyn.
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To export logs:

1. From the Filemenu, select Export >Wells.

The Export Wells dialog box appears.

2. Click Selection criteria to display the Selected curves must have dialog box
and CTRL+CLICK the logs to automatically select based on type, author, and
more; otherwise, click the individual logs to export.

A check mark ( ) appears beside logs that will export, a cross ( ) beside those
that won't.

3. Select whether to convert exported logs into GeoSyn or LAS format.

Related Topics
"Importing LAS or GeoSyn files from disk" on page 18
"Exporting tops lists" on page 146

Exporting log aliases
Export a list of all the aliases GeoSyn uses to recognize imported logs. The file is
exported in ASCII format and you can view it using numerous third-party
products to determine whether GeoSyn is using a desired alias.

To export log aliases:

1. From the Edit menu, select Configuration Properties > Log Library.
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The Properties: Log Library tab appears.

2. Click Export alias list.

3. Browse to a location in which to save the file, and then click Save.

Now open the file using a third-party application such as Microsoft Excel or Win-
dows Notepad.

Related Topics
"Changing log definitions" on page 105

Changing log editor display
Change the minimum and maximum values that define the scale range for logs.

To change log editor display:
1. Open the log editor:

l Edit > Log editing

l Double click on a log in the model.

l Right-click on a log and select Log editing.

2. In the log editor toolbar click the Set log editor scales tool ( ).
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The Log Editor Display Properties dialog box appears.

3. In the display pane, select the log and type minimum and maximum
scale values in the boxes below the display pane then click Close.

Note: These changes apply to only the current model. To change the
default scale for a log in all future synthetics

Related Topics

"Changing log definitions" on page 105
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Drawing Straight Edge and Freehand
Curves
Draw a single segment straight line or multi-segment freehand line to replace a
curve portion.

To draw straight edge and freehand curves:
1. Open the log editor:

l Edit > Log editing

l Double click on a log in the model.

l Right-click on a log and select Log editing.

2. Click either the straight line ( ) or freehand tool ( ).

3. Hover the cursor ( or ) over the location at which to draw a line. The
cursor position appears in the banner of the Log Editor.

4. Starting at the top or bottom of the log portion to change, drag to draw the line.

5. Click End Draw in the popup dialog box to complete the line.

Related Topics
"Creating Blocked Log Models" on page 119
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Inserting log sections
Create a section of log with a constant value and insert it at a specific depth to
provide a time datum shift or to provide room for new geological section. You can
also specify whether to raise or lower the log start depth or stop depth to accom-
modate the insertion.

When you insert a section in any log, new data is inserted in all logs throughout
the model. You can specify different constant values to insert in each of the indi-
vidual logs.

To insert log sections:
1. Open the log editor:

l Edit > Log editing

l Double click on a log in the model.

l Right-click on a log and select Log editing.

2. Select the tab for the log in which to insert a log section and in the Log
Editor toolbar, click the Insert Section tool ( ).

The Insert Constant Value Log Section dialog box appears.
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3. Hover the cursor ( ) at the top of the zone at which to insert a log
section. The cursor position appears in the banner of the Log Editor.

4. Drag to the bottom of the zone.

5. In the Insertion point pane, type a more precise depth at which to
insert the log section or click top or bottom to select the absolute top
or bottom of the log.

6. In the Insertion range box, type the thickness to insert. This section is
inserted in every log throughout the synthetic.

7. In the Insertion values display pane, select a log to display the con-
stant value that will be inserted in the Edit log insertion value box and
each of the logs. Type a different constant value if desired.

8. Select whether to raise the start depth or lower the stop depth and
click Apply.

Related Topics
"Cutting logs" on page 128
"Shifting logs" on page 132

Inserting tops
When inserting a top at a location on a log , you can specify the tops list to which
to write the top information so that you can update it, correlate it, and so on.

To insert tops:
1. Open the log editor:

l Edit > Log editing

l Double click on a log in the model.

l Right-click on a log and select Log editing.

2. Select the tab for the log in which to insert a top and in the Log Editor
toolbar, click the Insert a Top tool ( ).

3. Click the cursor ( ) at the location on the log at which to insert a top.
The Insert Top in Selected List dialog box appears.

4. Select the list in which the name and depth of the top you insert will be
saved, and then type a name for the top and click OK.

Related Topics
"Managing tops" on page 29
"Changing tops properties" on page 31
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Creating Blocked Log Models
Block sections of existing logs using Log Editor so that GeoSyn, working within
the highlighted zone, applies the mean, median, or RMS value between two tops
to each set of tops.

To block portions of existing logs using Log Editor:
1. Open the log editor:

l Edit > Log editing

l Double click on a log in the model.

l Right-click on a log and select Log editing.

2. In the log editor toolbar click the Blocking tool ( ).

The Log Blocking dialog box opens.

3. Select the algorithm used to derive a constant value that's applied to
the zone between shallowest and deepest tops within your selection.
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GeoSyn automatically connects your selection to the nearest top.

4. Select the log(s) to block.
CTRL+CLICK or SHIFT+CLICK for multiple selection.

5. Do one of the following:

l Drag the cursor ( ) on the Log Editor log display pane to select a range
to block.

l Type values in the Depth range KB pane for the start and stop depth and
click Update.

l Click either top or bottom to accept the absolute depth from the log or
click All to accept both.

l Click Depths from tops to display the Depth Range from Tops dialog
box and then select the formation tops that signify your zone of interest
from the drop-down lists and click OK.

6. Click Apply.

Related Topics
"Drawing Straight Edge and Freehand Curves" on page 116
"Clipping or filtering logs" on page 122
"Cutting logs" on page 128
"Inserting log sections" on page 117
"Applying math equations to logs" on page 124
"Shifting logs" on page 132

Stretching and squeezing Logs
Stretch and squeeze a selected log portion in either time or depth using the Log
Editor, which displays the log view in depth, or stretch it in time using the Cor-
relation Window, which enables you to hover the log over seismic.

Stretch and squeeze functionality is also available when tying seismic to models
or by specifying values when importing check shot surveys. For details, see
Related Topics below.

To stretch and squeeze logs:
1. Open the log editor:

l Edit > Log editing

l Double click on a log in the model.
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l Right-click on a log and select Log editing.

2. Select the tab for the log to stretch or squeeze and in the Log Editor
toolbar, click the Stretch Squeeze tool ( ).

The Stretch/squeeze log curves in time dialog box appears.

3. Select whether to stretch or squeeze the log in time or depth.

4. Do one of the following:

l Drag the cursor ( ) on the Log Editor log display pane to select a range
to stretch or squeeze. The cursor position appears in the banner of the
Log Editor.

l Type values in the Set depth range KB pane for the start and stop depth
and click Update.

l Click either top or bottom to accept the absolute depth from the log or
click All to accept both.

l Click Depths from tops to display the Depth Range from Tops dialog
box and then select the formation tops that signify your zone of interest
from the drop-down lists and click OK.

5. Do one of the following:

l If you selected depth above, type the desired thickness of the zone
defined above after stretching or squeezing. If the value is less than the
difference between the start and stop depth, the log will be squeezed. If
more, the log will be stretched.

l If you selected time above, type a value by which to adjust the transit
times for the zone defined above and the number of samples over which
to taper the change.
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6. Click Apply.

Related Topics
"Clipping or filtering logs" below
"Cutting logs" on page 128

Clipping or filtering logs
Clip the data of either an entire log or a zone of interest within that log to remove
data spikes or incorrect data.

To clip or filter logs:
1. Open the log editor:

l Edit > Log editing

l Double click on a log in the model.

l Right-click on a log and select Log editing.

2. In the log editor toolbar click the Log Editor, click the Clip tool .( ).
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The Clip or filter the log dialog box appears.

3. Select whether to clip and filter by substituting values, removing
spikes, or using averaging methods.

4. Do one of the following:

l Drag the cursor on the Log Editor log display pane to select a range to
clip or filter.

l Type values in the Select depth range KB pane for the start and stop
depth and click Update.
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l Click either top or bottom to accept the absolute depth from the log or
click All to accept both.

l Click Depths from tops to display the Depth Range from Tops dialog
box and then select the formation tops that signify your zone of interest
from the drop-down lists and click OK.

5. Click Apply.

Related Topics
"Applying math equations to logs" below
"Creating Blocked Log Models" on page 119

Applying math equations to logs
The Math dialog box enables you to generate derived logs based on readings from
other logs as inputs. The log reading inputs are used as variables in either com-
mon industry equations provided by GeoSyn by default, or you can create your
own equations. The equation calculates values on a sample by sample basis as it
moves down the log.

The logs from which those readings are drawn as well can by either standard log
types provided by GeoSyn (sonic, density, resistivity), or log types that you cre-
ate. You can set any log type in GeoSyn (including a derived log type that you
create) as the active log upon which synthetics are based.

Equations describing common relationships such as density to sonic and res-
istivity are available from a function library.

For details about merging log runs, see Related Topics below.

About the function library
(missing or bad snippet)

To applymath equations to logs:

1. Right-click the log and select Log editing.
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The Log Editor dialog box appears.

2. In the toolbar beside the Log Editor, click the Math tool ( ).
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The Log Math dialog box appears.

To copy a portion of one log to another, enter the following equation XX=YY,
(where XX is the recipient log and YY is the source log) drag the interval to copy
in the source log, and then click Apply.

3. Do either of the following:

To build an equation based an equation in the function library, select the equation
from the Add a function from the library drop-down list,
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and then do either of the following to modify the equation. If the desired function
doesn't appear, click Edit to the right of the drop-down list to launch the Log Equa-
tion Editor dialog box and create it.

Type equation terms directly in the top box of the Compose an equation pane.

Select equation terms from the drop-down lists above the Add a function from the
library drop-down list.

4. Using the Log Resolution pane, select a log from each drop-down list to the
right of each equation term to associate a log with each term.

5. Do one of the following:

l Drag the cursor ( ) on the Log Editor log display pane to select a range
to which to apply the mathematical equation.

l Type more precise values in the Depth range KB pane for the start and
stop depth and click Update.Click either Top or Bottom to accept the
absolute depth from the log or click All to accept both.

l Click Depths from tops to display the Depth Range from Tops dialog
box and then select the formation tops that signify your zone of interest
from the drop-down lists and click OK.

6. Click Apply.

Related Topics
"Clipping or filtering logs" on page 122
Merging Logs
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Building Equations using the Log Equation Library

Cutting logs
Cut a section from a log and then either lower the start depth or raise the stop
depth so that either the tops below or above the cut maintain accurate depths.

If you change the shallowest or deepest depth in the entire depth page, also res-
ize the model by either dragging the canvas borders or by changing the display
range in the Display Parameters: Depth Model tab so that portions of the depth
model that aren't occupied by any wells, but that would otherwise influence your
time model, are removed.

You can also insert a constant value log section the same thickness as the sec-
tion removed. For details, seeRelated Topics below.

To cut logs:
1. Open the log editor:

l Edit > Log editing

l Double click on a log in the model.

l Right-click on a log and select Log editing.

2. Click the Cut tool ( ) on the Log Editortoolbar.

The Cut dialog box opens.

3. Do one of the following:

l Drag the cursor ( ) on the Log Editor log display pane to select a range
to cut.

l Type more precise values in the Depth range pane for the start and stop
depth and click Update.

l Click either top or bottom to accept the absolute depth from the log.

l Click Depths from tops to display the Depth Range from Tops dialog
box and then select the formation tops that signify your zone of interest
from the drop-down lists and click OK.
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4. Click Apply.

Related Topics
"Inserting log sections" on page 117
"Shifting logs" on page 132

Creating log composites
Take a range of data from a donor well and either insert it into or replace part of a
host well.

Log data from the specified depth range of the donor well is copied to the cor-
responding log type in the host well. Logs in the donor well without corresponding
logs in the host well are ignored unless you manually associate them with logs in
the host well.

To create log composites:
1. Open the log editor:

l Edit > Log editing

l Double click on a log in the model.

l Right-click on a log and select Log editing.

2. In the toolbar beside the Log Editor, click the Composite tool ( ).
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The Import log data dialog box opens.

3. Select the root directory or drive from the Look in drop-down list then
double-click folders in the display pane to browse to the directory that
contains either the desired files or the subdirectory with those files. To
filter the type of files displayed, from the File filter drop-down list,
select a file format extension.

4. Either click Browse dir. or Browse sub-dir to launch Directory
Browser displaying LAS and GeoSyn files sorted by UWI, or simply
select the desired file in the display pane. For details on using Directory
Browser, see Related Topics below. For LAS files, you can inspect and
modify the raw data in an ASCII text editor before importing it by click-
ing File Viewer.When you select the file, details appear in the format
file pane.

5. In the well tree, select whether to import specific logs. A check mark (
) appears beside logs that will import, a cross ( ) beside those that

won't. For wells with numerous logs, toggle the group by clicking All
depending on whether to import or ignore the majority of logs then
toggle the individual logs to import or ignore and click Import.
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The Log Composite dialog box opens displaying which logs from the donor
well will be inserted into logs of the host well.

6. Logs that match appear in the pane to the right. Logs that don't com-
pletely align and for which some constant values will need to be applied
are colored red in the cell between the donor and recipient log.

l Drag a log from the Unmatched pane into the Matched pane in the left-
most cell of the row that lists the desired recipient log, or drag it from the
Matched pane to the Unmatched pane if you don't want it to be a donor
log.

l Drag the alias in the left-most column of the Matched pane to change the
default recipient log.

7. Do one of the following:

Type precise values in the Copy range and Replacement range boxes and then
click Update.

l Click top and bottom to accept the absolute depth from the log.

l Click Depths from tops to display the Depth Range from Tops dialog
box and then select the formation tops that signify your zone of interest
from the drop-down lists and click OK.

8. Click Apply and then click Close.
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Related Topics
"Clip or filter the log" on page 173
"Inserting log sections" on page 117
"Using Directory Browser" on page 19
Merging Logs

Shifting logs
Correct log depths with cable stretch and other errors by adding a segment to the
top or bottom of one or multiple logs in the current model. New data points added
to the top or bottom of logs are extrapolated using the last available data point. If
the top or bottom value is anomalous, it will be propagated and may require fur-
ther editing.

GeoSyn requires that all logs have the same top and bottom, so when one log is
shifted in depth, GeoSyn adds data to the top or bottom of all logs to com-
pensate.

To shift logs:
1. Right-click the log and select Log editing.
The Log Editor dialog box opens.

2. In the toolbar beside the Log Editor, click the Shift tool ( ).

The Shift Curve dialog box opens.

3. In the display pane, select the logs to shift. SHIFT+CLICK or
CTRL+CLICK for multiple selection.

4. Type a signed value to shift the log(s) in the Shift selected curves
box then click Apply.
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Related Topics
"Cutting logs" on page 128
"Drawing Straight Edge and Freehand Curves" on page 116
"Inserting log sections" on page 117
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Modeling fluid replacement
In Amplitude vs. Offset modeling, as seismic waves reflect off an interface, the
amplitude of the reflected wave is affected by the amount and type of fluid that
occupies the pore space of the rock.

GeoSyn applies Gassman's equation to model this using a P sonic, shear sonic,
and density log. You change the water saturation to apply different scenarios to
your model. The available pore space not saturated with water is assumed to con-
tain oil and gas.

Click for in-depth details on how fluid replacement modeling is implemented in
GeoSyn.

To model fluid replacement:
1. Open the log editor:

l Edit > Log editing

l Double click on a log in the model.

l Right-click on a log and select Log editing.

2. In the toolbar beside the Log Editor, click the Fluid Replacement
Modeling tool ( ).
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The Fluid Replacement Wizard (Input and output logs, depth range) dialog
box opens.

3. GeoSyn automatically populates the Input logs and Output logs drop-
down lists if the required logs are available in your model; otherwise,
click Log tool kit to display the Fluid Replacement Tool Kit dialog box
and complete the three bullet steps below.

The Fluid Replacement Tool Kit dialog box opens.

4. Click Create.
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The AVO log suite dialog box opens.

5. Click the log types to create in the left column and ensure Maintain
link is cleared so that changes you make to the derived log aren't over-
written by the parent log, and then click OK.

l Click Edit to the right of a log type to display the Edit the Derivation Equa-
tion for Log dialog box and modify the equation used to derive the log.

l Using the Fluid Replacement Tool Kit dialog box, click Duplicate to copy
the created logs to the Output logs pane of the Fluid Replacement Wizard
(Input and output logs, depth range) dialog box.

l If you want to undo fluid replacement changes made to the output logs,
using the Fluid Replacement Tool Kit dialog box above, click Duplicate to
refresh the output logs with the original input logs data.

6. Click Next.
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The Fluid Replacement Wizard (In-situ reservoir properties) dialog box
opens.

7. Select default Rock matrix, Hydrocarbon, and Water/brine types from
the drop-down lists in the Rock matrix and Fluids panes. For Water sat-
uration, instead of typing a percentage in the field, you can drag the
slider below it to change the value and note the effect it has on the
Bulk modulus and density values in the bottom portion of the dialog
box.
For detailed calculations, click Calculator in the Rock matrix and Flu-
ids panes to display either the Minerals Calculator or the Batzle and
Wang Fluid Properties Calculator dialog boxes and select values more
specific to your zone of interest.

8. Click Next.

The Fluid Replacement Wizard (Calibrate shear log for water saturations <
100%) dialog box appears if the water saturation defined using the previous
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dialog box is less than 100%.

The above dialog box is used to compensate for the fact that the shear log is
frequently derived from a sonic log using Castagna's formula. Castagna's for-
mula requires a correction when gas is present in the zone of interest.
l Select the check box and click Next.
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The Fluid Replacement Wizard (FRM Modeling: Set new water saturation) dia-
log box appears.

9. Ensure the above dialog box doesn't overlap the Log Editor displaying
the well for which you're modifying water saturation, and then drag the
slider while viewing the affect in the Log Editor dialog box and in the
model.

10. Click Apply to save these changes to the log.

Related Topics
"Changing log display properties" on page 106
Notes on GeoSyn Fluid Replacement
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Printing models
By default, a printer page outline appears on the main display bounding the area
that will fit on the paper size selected for the default printer. Toggle whether the
printer page outline appears using the Display Parameters ( ) > Global dialog
box.

Because most printers don't print right to the edge of the page, an additional
three-quarters of an inch of image inside the print margin won't be printed. If you
change the paper size using the File > Print Setup dialog box, the page outline in
the main display changes too.

If your model exceeds the printer page outline, those portions of the model won't
print. Ensure you select a page size large enough to include your entire model in
the File > Print Setup dialog box.

To print models:
1. Verify how the current page will appear when printed by selecting File
> Print Preview.
The Print Preview dialog box opens.

2. From the Filemenu, select Print ( ), or click Print in the Print Pre-
view dialog box above.
The Print dialog box opens.

3. Select the desired print options then click OK.

Related Topics
"About depth models" on page 88
"About Time Models" on page 70
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Exporting depth fields
Depth fields are exported as an ASCII text file that delineates the impedance field
in depth. Other applications can import this file to generate a sophisticated time
model based on wave equations or ray tracing.

To export depth fields:
1. From the Filemenu, select Export > Depth field in ASCII format.

2. Browse to the desired location, type a file name, click Save.

3. Open the generated file in an ASCII text editor to view the specific data
fields exported.

Related Topics
"Exporting logs" on the next page

Exporting time data
Time data is exported in SEGY binary format (for importing in geophysical work-
stations) that can be used by other seismic applications. You must specify the X
and Y positions of the first trace in Universal Transverse Mercator format.

To export time data:

1. From the Filemenu, select Export > SEGY format > and then Reflection
Coefficients, Impedance, Amplitude, or Current Display Option.
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The Assign Geometry to Seismic File dialog box appears.

2. Click Edit to display the Edit EBCDIC Header dialog box.

3. Type seismic line and trace parameters in the various boxes then click OK.

Related Topics
Exporting reflection coefficient data in SEGY format
"Exporting wavelets and sets" on page 144
Exporting horizons

Exporting logs
Well logs can be exported in LAS format to use with other geologic applications as
well as GeoSyn, or exported to GeoSyn format to use only with GeoSyn.

To export logs:

1. From the Filemenu, select Export >Wells.
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The Export Wells dialog box appears.

2. Click Selection criteria to display the Selected curves must have dialog box
and CTRL+CLICK the logs to automatically select based on type, author, and
more; otherwise, click the individual logs to export.

A check mark ( ) appears beside logs that will export, a cross ( ) beside those
that won't.

3. Select whether to convert exported logs into GeoSyn or LAS format.

Related Topics
"Importing LAS or GeoSyn files from disk" on page 18
"Exporting tops lists" on page 146

Exporting log aliases
Export a list of all the aliases GeoSyn uses to recognize imported logs. The file is
exported in ASCII format and you can view it using numerous third-party
products to determine whether GeoSyn is using a desired alias.

To export log aliases:

1. From the Edit menu, select Configuration Properties > Log Library.
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The Properties: Log Library tab appears.

2. Click Export alias list.

3. Browse to a location in which to save the file, and then click Save.

Now open the file using a third-party application such as Microsoft Excel or Win-
dows Notepad.

Related Topics
"Changing log definitions" on page 105

Exporting wavelets and sets
You can export individual wavelets in ASCII or SEGY format, or export multiple
wavelets bundled as a wavelet set in .wav format. Wavelets can be saved and
imported using a centralized library of wavelets you create. The wavelet library is
accessed by all GeoSyn projects.

For details on extracting a zero phase wavelet, see Related Topics below.

To export wavelets:
1. From the Edit menu, selectWavelet ( ).
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The Wavelet Properties dialog box appears.

2. In the Selected wavelet attributes pane, besideWavelet, click Export, or
click Add to the right of the Library label to add the wavelet to the centralized
Wavelet Library shared by all GeoSyn models.

3. Browse to a disk location in which to save the file then click Save.

Related Topics
"Extracting wavelets" on page 84
"Exporting time data" on page 141
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Exporting tops lists
You can save tops lists to disk in ASCII format. The exported file contains form-
ation names, depths, a units flag, and the Kelly Bushing depth. If you select mul-
tiple lists to export, they're written to a single file that you can then edit to
remove duplicate entries.

To export tops lists:

1. Right-click a log and select Tops properties.

The Top Properties dialog box appears.

2. In the Tops lists pane, select the tops list(s) to export to disk and then click
Export. CTRL+CLICK or SHIFT+CLICK for multiple selection.

3. Browse to a disk location in which to save the file, type a file name, and then
click Save.
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The tops are written to the file based on the order in which the tops lists appear in
the Tops lists pane above and in the order in which the individual tops names
appear in each list. Duplicate tops names aren't overwritten.

Related Topics
"Managing tops" on page 29
"Importing tops from delimited files" on page 32
"Importing tops from fixed width files" on page 35
"Importing tops from GeoSyn files" on page 42
"Exporting logs" on page 142

Exporting tops tables
GeoSyn displays a list of tops in a tops table that can be exported in either .emf
or ASCII text for other applications. When multiple tops lists are shown in the
main display, all tops are grouped in one tops list. To display lists separately in
the main synthetic display (such as a list of check shot values and a list of tops),
show one of the lists in the main synthetic display and copy and paste it into
GeoSyn, then hide the original list —not the pasted one, and show the other list.

You can copy the data that appears in the tops table as either a static image or as
ASCII text.

Tops tables copied as ASCII text can be pasted into other applications for modi-
fication including AccuMap Tops Manager, with which you update the AccuMap
user tops database.

When the tops table is shown in the main synthetic display, it offsets other syn-
thetic elements instead of floating over them. Tops tables copied as images can
be pasted back into the main synthetic display as floating images without off-
setting other synthetic elements or pasted into other applications to create a
montage.

To export tops tables:

1. To display the tops table, from the Edit menu, select Synthetic properties (
) and in the Synthetic Properties dialog box, select the Tops table check box

and the adjacent position radio button.

2. Right-click the tops table and from the popup menu, select one of the fol-
lowing:
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Copy tops table image to load an image in the Windows clipboard that can be
pasted into other applications or pasted back into GeoSyn.

Copy name and md depth to load only top names and measured depth values
into the Windows clipboard as ASCII text to paste into a text editor or spread-
sheet application.

Copy all tops info to load all information that appears in the tops table into the
Windows clipboard as ASCII text to paste into a text editor or spreadsheet applic-
ation.

Export tops to display the Export Manager and write tops data to disk in ASCII
format.

Related Topics
"Duplicating tops lists" on page 49
"Managing tops" on page 29
"Exporting logs" on page 142
"Exporting tops lists" on page 146
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Appendices
"File formats" on
page 287

.ihs, .syn, .las, .segy

"Well symbol legend" on
page 293

Table of well symbols provided in GeoSyn 2D

"Wizards and dialog
boxes " below

Alphabetical listing of all user dialogs

Wizards and dialog boxes
The following pages provide descriptions and definitions of all the wizards and dia-
logs used in GeoSyn.

Auto correlation wizard
With this feature... Do this...

Ignore case Select whether
to link tops with
the same com-
bination of let-
ters regardless
of case.

Ignore blanks Select whether
to link tops with
the same com-
bination of let-
ters regardless
of inter-letter
spaces.

© 2020 IHS Markit™. All Rights Reserved 149



Appendices

Compare first Specify the num-
ber of matching
letters after
which tops are
automatically
linked.

Ignore correlations that tie Specify the num-
ber of wells with
matching tops
(subject to the
selection criteria
selected above)
after which tops
are auto-
matically linked.
Because only
correlations that
span the entire
cross section cre-
ate zones, you
may want to spe-
cify a value
that's one less
than the total
number of wells
in your cross sec-
tion.

Parent Topics
Creating Correlations
Create Well Correlations dialog box

Crossplot wizard: Select data type
With this feature... Do this...

Depth data Time data Select whether to base the crossplot on depth or
time readings.

Parent Topics
"Creating crossplots" on page 55
"Crossplot wizard: Select axis data" on the facing page
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Crossplot wizard: Select axis data
With this feature... Do this...

Display pane Click the log upon which to base first the X and then
the Y axis.

Parent Topics
"Creating crossplots" on page 55
Data Search Wizard: Select data from catalog
"Crossplot wizard: Select data type" on the previous page

Crossplot wizard: Set the data range
With this feature... Do this...

Display pane Click the data upon which
to base the crossplot
based on the following:
Select all to select the
entire log depth.
Define a data range to
display the Define Data
Window dialog box and
specify the portion of the
log.
Pre-selected Data
Range to use the depth
range specified in the Log
Inspection dialog box,
which is launched from
the Log Editor.

Parent Topics
"Creating crossplots" on page 55
"Define data window" on page 186
"Crossplot wizard: Select axis data" above
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Fluid replacement wizard: Input and output logs,
depth range

With this feature... Do this...

Log tool kit Click to display
the Fluid
Replacement
Tool Kit dialog
box to populate
the input and
output logs.

Input logs
(P Sonic, S Sonic, Density)

GeoSyn auto-
matically pop-
ulates these
boxes with P
wave, shear
sonic, and dens-
ity logs if
they're present
in your model.
Otherwise,
click Log Took
Kit above to
derive them
from other logs.
The input logs
are the source
logs for Gass-
man's equation.

Porosity Select either a
constant poros-
ity percent
(most com-
mon), or derive
the porosity per-
cent from a
density log.
Note that a
porosity log
derived from a
density log may
not be accurate
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for zones in
which gas is
present.

Porosity units Select a scale of
either 0-10 or
0-100. GeoSyn
analyzes the
data extents
and picks the
units that seem
most likely, but
you can over-
ride them if
some abnormal
data values
cause GeoSyn
to select the
wrong units.

Output logs Initially, these
are copies of
the input logs,
to which you
then apply fluid
replacement
changes.
Specify *Act-
ive logs in the
drop-down lists
so that fluid
replacement
changes are
automatically
reflected in the
current model.

Depth range KB Do one of the fol-
lowing:
Type start and
stop depths and
click Update.
Click either
Top or Bottom
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to select an
absolute depth
from the log, or
click All to
select both.
Click Range
from tops to
select a zone of
interest using
the formation
top names that
also appear in
the tops list
selected in the
Top Properties
dialog box.
Tip: You can
also use your
mouse pointer
to drag a spe-
cific zone on the
Log Editor to
specify a zone
of interest.

Parent Topics
"Modeling fluid replacement" on page 134
"Fluid replacement tool kit" on page 225
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Fluid replacement wizard: In-situ reservoir prop-
erties
With this feature... Do this...

Rock Matrix Select the reservoir rock
from the drop-down list to
populate the Bulk modulus,
Shear modulus, and Density
fields with typical values,
which you can change.
When you change a value,
the drop-down list above the
Bulk modulus field displays
Custom.
For detailed derivations,
click Calculator to display
the Minerals Calculator dia-
log box and specify the min-
eral composition in your zone
of interest.

Hydrocarbon Select the hydrocarbon to
populate the Bulk modulus
and Density fields, which you
can change.
When you change a value,
the drop-down list above the
Bulk modulus field displays
Custom.
For detailed derivations,
click Calculator to display
the Batzle and Wang Fluid
Properties Calculator dialog
box and specify more precise
values for your zone of
interest.

Water/Brine Select the reservoir fluid to
populate the Bulk modulus,
Density, and Water sat-
uration fields, which you can
change.
When you change a value,
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the drop-down list above the
Bulk modulus field displays
Custom.
For detailed derivations,
click Calculator to display
the Batzle and Wang Fluid
Properties Calculator dialog
box and specify values spe-
cific to your zone of interest.
For the Water saturation
value, instead of typing a
value, you can instead drag
the slider below the field.
Note that the fluid average
at the bottom of the dialog
box changes as you change
the water saturation per-
centage.

Fluid Average Select Reuss iso-stress if
fluid ratios are consistent in
pores throughout the zone of
interest; otherwise, select
Voight iso-strain.

Parent Topics
"Modeling fluid replacement" on page 134
"Fluid replacement wizard: Input and output logs, depth range" on page 229
"Batzle and Wang Fluid Properties Calculator" on page 169
"Minerals calculator" on page 251

Fluid replacement wizard: Calibrate shear log for
water saturations < 100%
This dialog box only appears if the water saturation defined using the previous dia-
log box is less than 100%.
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With this
feature...

Do this...

Apply cor-
rection
using
Mavko's
Procedure

It's recommended that you select this to compensate for the
fact that the shear log is frequently derived from a sonic log
using Castagna's formula. Castagna's formula requires a cor-
rection when gas is present in the zone of interest.

Edit Click to display the Edit the Derivation Equation for log dialog
box and change the formula.

Parent Topics
"Modeling fluid replacement" on page 134
"Edit the derivation equation for log" on page 220

Fluid replacement wizard, FRM modeling: Set new
water saturation
With this fea-

ture...
Do this...

New Water Sat-
uration %

Drag the slider while viewing the effect in the Log Editor dia-
log box and in the model.
Click Apply to save these changes to the log.

Parent Topics
"Modeling fluid replacement" on page 134
"Fluid replacement wizard: In-situ reservoir properties" on page 227
"Fluid replacement wizard: Calibrate shear log for water saturations < 100%"
on page 226

Import wizard: Highlight last data line in red
With this feature... Do this...

Display pane Click to define the last line of data to import.

Parent Topics
"Importing tops from fixed width files" on page 35
"Importing directional surveys" on page 23
"Importing wavelets and sets" on page 77
"Import wizard: Highlight first data line in red" on the next page
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"Import wizard: Set column delimeters" below

Import wizard: Highlight first data line in red
With this feature... Do this...

Display pane Click the first line of data
(not column headers) to
import.

Parent Topics
"Importing tops from fixed width files" on page 35
"Importing directional surveys" on page 23
"Importing wavelets and sets" on page 77
"Import wizard: Highlight last data line in red" on the previous page

Import wizard: Set column delimeters
With this feature... Do this...

Fixed width Tab Comma Select the
character
used to
separate
values in
the file
being
imported.

Display pane Click to
place a
column
delimeter
( ) before
a column
of data to
import or
double-
click to
remove an
existing
delimeter.
Delimeters
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need to be
placed on
both the
left and
right of
columns to
import.

Identify for Import Click and
select the
column
type from
the Select
from list
dialog box.
Columns
without
headers
aren't
imported.

Parent Topics
"Importing tops from fixed width files" on page 35
"Importing directional surveys" on page 23
"Importing wavelets and sets" on page 77
"Import wizard: Highlight last data line in red" on page 157
"Import wizard: Finish" below

Import wizard: Finish
With this feature... Do this...

Display pane (for tops, check shot, and directional
survey imports)

Review
the data
that will
be impor-
ted and
click Back
to make
any
changes.

Start time End time Sample rate (for wavelet Type the
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imports) Time data... interval
time and
sample fre-
quency.

Parent Topics
"Importing tops from fixed width files" on page 35
"Importing directional surveys" on page 23
"Import wizard: Set column delimeters" on page 158

Data search wizard: Define search range
With this feature... Do this...

Add Location Add Range Click to display
the Edit a UWI dia-
log box and select
the survey sys-
tem then type
coordinates
within which to
retrieve logs.

Remove All Select the spe-
cific location or
range in the dis-
play pane and
click Remove, or
click All to clear
all locations and
ranges from the
list.
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Recent Searches Select a search
you previously
conducted from
the drop-down
list.

Data Source Select whether to
retrieve logs from
the
IHS Information
Hub or from a
local or net-
worked drive.
Click Edit online
configuration to
display the Prop-
erties: Con-
figuration dialog
box and change
folders in which
downloaded logs
are saved and
your connectivity
parameters for
the IHS Inform-
ation Hub. For
GeoSyn network
installations, con-
nectivity para-
meters (except
user name) affect
all GeoSyn users.

Edit user paths Click to display
the Set Source
and Target dir-
ectories dialog
box where you
select the source
to search for data
and the location
in which to save
downloaded files.
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Parent Topics
"Downloading logs from the IHS information hub" on page 15
Data Search Wizard (Select data from catalog)

Data search wizard: Select data from catalog
With this feature... Do this...

Node expansion but-
tons
( )

Click to expand or con-
tract all well nodes in
the display pane.

Auto Select Click to display the Auto
Curve Selection dialog
where you specify the
curve type, author, and
other details with which
to select rows. To select
all logs for a well, simply
click the well.

Select all Deselect all Click to toggle all logs in
the display pane.

Display Layout Before specifying the
Selection criteria
above, click to display
the Catalog display
options dialog box and
specify the parameters
under which wells
appear in the display
pane.

Report Click to output the
information that cur-
rently appears in the dis-
play pane to an ASCII
text file.

Display pane Click + and - to expand
or contract individual
nodes and select the
desired logs. To select
all logs for a well, simply
click the well.
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Show Toggle whether wells
with digital sonic, digital
density, and a specific
depth appear in the dis-
play pane. GeoSyn auto-
matically creates a
constant velocity sonic
log if none is available in
the downloaded log.
Specify whether undi-
gitized logs and dir-
ectional surveys appear
in the display pane. If
you try to download an
undigitized log, an
online digitization
request form appears
that you submit to IHS.
Showing wells without
data enables you to at
least determine that a
well UWI exists in the
data.

Hide if well Click whether wells with
digital sonic or density,
or that don't reach a cer-
tain depth appear in the
display pane.

Group multiple runs Select whether to merge
the overlapping portions
of curves. Further merge
options such as whether
to merge only curves
from a common source
and whether to trim the
shallower or deeper
curve appear in the Data
Search Wizard: Save
Options dialog box,
which appears after you
click Next.
By default, data on the
IHS Information Hub is
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metric, but it can be con-
verted to Imperial.

Parent Topics
"Downloading logs from the IHS information hub" on page 15
"Auto curve selection" on page 263
"Data search wizard: Define search range" on page 160
"Data search wizard: Model display and data save options" below

Data search wizard: Model display and data save
options

With this feature... Do this...

2D model creation Select from the fol-
lowing options:
Import data into
2D model - whether
to import well and
related data directly
into the model or
save it as an LAS file
on disk.
Set model depth
range to minimum
- whether to trim the
depth of the model
to match the bottom
of wells within that
model.
Order wells west
to east - whether to
order wells using the
UWI. Click Order
wells manually to
drag and drop them
in the desired loc-
ations.

LAS save options Specify whether
downloaded curves
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are saved to the
default target dir-
ectory.
Depth increment -
select the depth
increment with
which curves will be
resampled. If you
select User defined
a second drop-down
list appears where
you type the desired
depth increment.
Using a larger depth
increment may mute
some curve details
in curves with a
small depth incre-
ment. Using a smal-
ler depth increment
may add some
undue influences in
curves with a large
depth increment.
Tops nomen-
clature - select the
naming terminology
for your tops.
Multiple runs -
select whether to
merge only curves
from the same
source and for
curves that are
merged, whether to
use the portion from
the shallower curve
(trim deep) or use
the portion from the
deeper curve (trim
shallow).

Directional survey save
options

When you select a
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directional survey in
the Online Data
Search Wizard:
Select Data from
Catalog dialog box,
specify the folder
and format in which
to save it. For dir-
ectional surveys to
be visible in Online
Data Search Wizard:
Select Data from
Catalog dialog box,
click Display and
select the Show ser-
vice curves check
box.

Parent Topics
"Downloading logs from the IHS information hub" on page 15
"Properties: Import defaults" on page 259
"Data search wizard: Select data from catalog" on page 162

Assign geometry to seismic file
With this feature... Do this...

EBCDIC Header Click Edit to
display the
Edit EBCDIC
Header dia-
log box and
change
selected val-
ues.

Group Interval Type the dis-
tance
between
groups of
geophones.

Source Interval Type the dis-
tance
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between
energy
sources.

Fold Type the
number of
traces
summed in
the stack
fold.

Azimuth Type the
clockwise
angle of
departure
from true
north.
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SP Type the
position of
the first
shot point.

CDP Type the
position of
the first
common
depth point.

X Y receiver location Type the loc-
ation of the
first
receiver
group in
UTM coordin-
ates, which
controls
where the
seismic line
appears on
the map
when impor-
ted into a
seismic
workstation
and the dir-
ection in
which the
waves
move.

Parent Topics
"Exporting time data" on page 141
Exporting horizons
Horizon Export dialog
Exporting reflection coefficient data in SEGY format
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AVO log suite
With this feature... Do this...

Log type Select the log type to cre-
ate.

Derive from Select to derive the log
using industry standard for-
mulas, which you can
modify by clicking Edit to
display the Edit the Deriv-
ation Equation for log dia-
log box.
Clearing both the Derive
from andMaintain link
checkboxes, creates a
straight line log.

Maintain link Ensure this check box is
cleared so that the parent
log doesn't overwrite
changes you make to the
derived log.

Parent Topics
Modelling Fluid Replacement
Fluid Replacement Tool Kit

Batzle and Wang Fluid Properties Calculator
With this feature... Do this...

Top portion of dialog box Specify the
pressure, tem-
perature, and
salinity of the
reservoir.

Hydrocarbon Specify
whether the
reservoir
includes gas
(most com-
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mon), and the
specific grav-
ity for the
hydrocarbons.
To simulate
dead oil (oil
without the
presence of
gas), reduce
the GOR to
zero.
Note: Click
Close to pre-
serve the val-
ues you've
specified, or
click Cancel
to restore the
previous val-
ues.

Parent Topics
Modelling Fluid Replacement
Fluid Replacement Wizard (In-Situ Reservoir Properties) dialog box

Break old correlation, rename new correlations
With this fea-

ture...
Do this...

New name Type a name by which to identify the correlations left
and right of the break point.

Parent Topics
"Edit correlations" on page 213
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Catalog display options
With this feature... Do this...

Curve Info Layout Order Toggle the
data type to
display and
drag and drop
mnemonics
to change the
order in
which log
information
appears in
the Online
Data Search
Wizard:
Select Data
from Catalog
dialog box.

Well Sorting Order Toggle
whether to
sort the
Online Data
Search Wiz-
ard: Select
Data from
Catalog dis-
play area by
UWI (and
click <> to
transpose
columns on
either side of
the <>), or
by sub-
surface or
kelly bushing
depth.

Display Filter Toggle
whether only
wells with
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digital sonic,
digital dens-
ity, and a spe-
cific depth
appear in the
display pane.
GeoSyn auto-
matically cre-
ates a
constant velo-
city sonic log
if none is
available in
the down-
loaded log.
Specify
whether undi-
gitized logs
and dir-
ectional sur-
veys appear
in the display
area. If you
try to down-
load an undi-
gitized log,
an online
digitization
request form
appears that
you submit to
IHS.

Display and download units Select
whether logs
are down-
loaded in met-
ric, imperial,
or original
units. For
Canadian
wells, original
units are
imperial if the
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log was run
before Janu-
ary 1, 1979.
All U.S. logs
are in imper-
ial units.

Parent Topics

Clip or filter the log
With this feature... Do this...

Select Logs Select the log
to clip or filter.

Clip and Replace Select to
replace values
outside of a
defined range
with specified
minimum and
maximum val-
ues.

DeSpike Select to
replace spikes
outside of a
defined range
with data val-
ues inter-
polated from
the last good
data point.

Median Mean Triangular filter Select to aver-
age the num-
ber of
samples
defined in the
Operator
length box by
the value that

© 2020 IHS Markit™. All Rights Reserved 173



Appendices

appears
exactly in the
middle of all
the values
within that
group when
sorted from
smallest to
largest
(median), the
value derived
from the sum
of all values
within a group
and divided by
the number of
values within
that group
(mean), or
the value
between three
points (tri-
angular).
Type a small
Operator
length (7 to
15 samples)
for de-spiking
and a large
Operator
length (>100)
to achieve an
approximation
of a blocked
log. 

Time filter Select to filter
log at seismic
resolution.
Click Edit to
set filter para-
meters: type,
center freq,
phase, taper
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and length.

Select depth range KB Do one of the
following:
Type start
and stop
depths and
click Update.
Click either
Top or Bot-
tom to select
an absolute
depth from
the log or click
All to select
both.
Click Depths
from tops to
select a range
using the form-
ation top
names that
also appear in
the tops list
selected in
the Top Prop-
erties dialog
box.

Parent Topics
"Clipping or filtering logs" on page 122
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Create a new correlation
With this feature... Do this...

Correlation Type a name for
the correlation or
accept the
GeoSyn default. If
you're correlating
a time marker,
you may want to
name the cor-
relation the same
as that time
marker, if you're
drawing a geo-
logic anomaly
such as a chan-
nel, you can
name the cor-
relation accord-
ingly.

Parent Topics
"Creating correlations" on page 94

Create new curve type
With this
feature...

Do this...

Name Type a descriptive name that appears above the log in the
main display.

API num-
ber

Type the API number.

Alias Either type a name in the adjacent box and click Add to include
it in the list of aliases associated with the log type or select an
alias to remove from the associated aliases and click Delete.
Generally, it's best to have as many aliases associated with a
log type as possible so they don't have to be added when
importing a GeoSyn or LAS file.

Curve infill Select whether to display a scaled color or lithology. For litho-
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logy to appear in the main synthetic display, formation litho-
logies must also be configured in the Top Properties dialog box.

Infill ori-
entation
Infill
palette
Trace

Select whether to fill the left or right side of the log, the color
palette to use (if scaled color is selected instead of lithology
above), and display properties for the trace line itself.

Metric to
Imperial
conversion
factor

Type a conversion factor.

Track
width

Type the desired track width to display in the main synthetic
display.

Lines Type Select the line type to display and whether to display them in
the foreground, background, or not at all.

Auto range Select to automatically adjust scales to actual data limits.

Parent Topics
"Correcting invalid data when importing" on page 21
"Well properties: Log properties" on page 280
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Create well correlations
With this feature... Do this...

Well display pane Right-click a
top and
select Edit
top to
change top
properties, or
right-click
the canvas
and select
Start new
correlation
and then
click a top in
each well to
which to
latch the new
correlation.

Depth Select
whether to
display either
or both sub-
sea and kelly
bushing
depths along-
side tops.

Wizard Click to
launch the
Correlation
Wizard dialog
box and spe-
cify the cri-
teria GeoSyn
uses when
automatically
correlating
tops.

Correlations Edit Click to dis-
play the Edit
Correlations
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dialog box
and change
top display
properties.

Tops Edit Click to dis-
play the
Select a well
dialog box,
choose the
well for which
to edit tops,
then click OK
and the Top
Properties
dialog box
appears.

Draw with mouse Click either
Start or End
to begin or
complete
drawing a cor-
relation
manually.

Parent Topics

"Creating correlations" on page 94

Crossplot properties: Color mapping
With this feature... Do this...

Enable color coding Select whether to display
the Gradational or Blocked
color coding in the Cross-
plot Viewer.

Brush Click to display a dialog
box from which you select
the desired color for either
gradational or block fill.

Link list Click the synthetic or log
on which to display the
data point highlighting.
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Parent Topics
"Creating crossplots" on page 55

Crossplot properties: Controls
With this feature... Do this...

Labels Clear the
check box
and type
different
text you
want to
appear in
the main
display.

Highlight data window Select
whether an
outline in
the main
display
shows the
portion of
the syn-
thetic on
which the
crossplot is
based.
Click Edit
to display
the Define
Data Win-
dow dialog
box and
specify the
depth or
time upon
which to
base the
crossplot.

Trend line Select
whether to
display a
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linear
regression
trend line
on the
crossplot.

Symbols Select the
symbol
size, color
scheme,
and data to
which to
link scatter
points.
Depending
on the
Color Refer-
ence type
selected,
when you
click Color
to display
the Edit
Color
Palette dia-
log box, a
Histogram
pane in the
Edit Color
Palette dia-
log box
enables
you to set
the min
max color
nodes and
thus con-
trol how
much of
the color
spectrum
is used
across the
data. When
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Depth is
specified
as the
Color ref-
erence, the
histogram
doesn't
appear in
the Edit
Color
Palette dia-
log box.

Width/Height Type the
crossplot
dimensions
and click
Update.

Parent Topics
"Creating crossplots" on page 55
Exporting crossplots
"Edit color palette" on page 210

Crossplot properties: Enclosures
With this feature... Do this...

polygon Click Start and
then click to define
the anchor points of
your polygon on the
crossplot canvas.
Click End to com-
plete and auto-
matically enclose
the polygon.

ellipse Type a value in the
eccentricity box
below then click
Start and click to
anchor one end of
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the ellipse. Move
your mouse to the
other desired end of
the ellipse and click
to anchor that
point.

Eccentricity Type a decimal
value from 0.01 to
0.99 where 0 rep-
resents a circle and
0.99 represents an
ellipse. Typing 1
draws a line instead
of an ellipse.

Name Type a meaningful
name for the selec-
ted annotation(s).

Color Click Outline,
Infill, or Both and
select the desired
color for the selec-
ted annotation(s).

Enclosure list Click Show to dis-
play the selected
annotation in the
Crossplot Viewer.

Link list Click the synthetic
or log on which to
highlight the data
points encom-
passed by an
annotation.

Parent Topics
"Annotating Crossplots" on page 61
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Crossplot properties: X and Y axis
With this feature... Do this...

Data Click Edit to select different
series data for the X or Y
axis.

Swap axis Click to switch the X and Y
axis.

Auto Clear to specify a axis
label, units, values, grid
options, and scale type
other than that auto-
matically calculated by
GeoSyn based on the cross-
plot data.

Parent Topics
"Creating crossplots" on page 55
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Cut
With this feature... Do this...

Depth range Type the
start and
stop depth
to remove
from the log,
click Top or
Bottom to
select either
the absolute
top or bot-
tom of the
log, or click
Depths from
Tops to spe-
cify a zone
of interest
using tops
selected for
display in
the Tops
Properties
dialog box .

Drop top of log Raise bottom
of log

Select
whether to
lower the
start depth
or raise the
stop depth
to com-
pensate for
the cut por-
tion. Depend-
ing on your
selection, all
log data
either above
or below the
cut portion
is shifted.
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Parent Topics
"Cutting logs" on page 128

Define data window
With this feature... Do this...

Sample Select a sample range
to plot. Time samples
are used for time plots
and depth samples are
used for depth plots.

Time Select a time range to
plot.

Depth Select a depth range to
plot based on Kelly Bush-
ing depth.

Top Select a depth range to
plot based on formation
tops.

Parent Topics
"Creating crossplots" on page 55
"Crossplot properties: Controls" on page 180
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Directory Browser
With this feature... Do this...

Survey system tabs  Click to select the
appropriate sur-
vey system. All
files with either a
.syn or .las exten-
sion (depending
on how you
launched this dia-
log box) appear in
the Labels tab,
regardless of
whether they
include a valid
UWI.

Display pane Click a column
header to sort
rows based on the
values in that
column.
Click <> to trans-
pose the columns
on either side of
it.
Right-click a file
to view basic log
details in a popup
window.

Filter Select then click
Edit, which
appears beside
the Filter box, to
display the Edit a
UWIdialog box
and specify the
geographic
coordinates within
which to display
UWIs in the Dir-
ectory Browser
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display pane.

Report Click to display
the Browser
report dialog box
then click Save
Report to save
the above display
to an ASCII
format file.

Restore order Click to restore
the original hori-
zontal and ver-
tical column
order.

Open Click to open the
file selected in the
display pane
above.
If Directory
Browser is opened
from the Import
log data or Open a
GeoSyn format
file dialog boxes,
you can only
select one file. If
it's launched from
the Batch printing
or Batch reformat
dialog boxes, you
can select mul-
tiple files.
SHIFT+CLICK or
CTRL+CLICK for
multiple selection.

Parent Topics
"Using Directory Browser" on page 19
"Import log data" on page 232
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Display parameters: Depth model
With this feature... Do this...

Top BottomWidth Specify the
dimensions of
the actual can-
vas. You can't
reduce the can-
vas size to less
than that of
wells unless
you click Trim
model below,
but you can
reduce the dis-
play range to
hide portions of
the model.

# Depth/time traces Type the total
number of
traces to dis-
play.

Width Depth inc. Type the depth
increment used
for the depth
model. This
value is defined
by your current
default file, not
the individual
wells on the
depth page.
The depth incre-
ment of indi-
vidual wells is
specified on the
Well properties
dialog box .
High-fre-
quency models
work better
with smaller
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depth incre-
ments, but
smaller depth
increments
also affect sys-
tem per-
formance.

Trim Click to display
the Trim depth
model dialog
box and specify
the zone of
interest above
and below
which to
remove can-
vas.

Trim to display range Click to trim
the model to
the display
range specified
below.

Display range sub-sea Type the zone
of interest to
include in the
model. You
may want to
trim models
when importing
them instead of
reducing the
display range
because super-
fluous data can
affect system
performance.

Scales Type the geo-
graphic dis-
tance
represented by
each model
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increment and
click Font to
change the
scale text dis-
play properties.

Label every Select the label
frequency from
the drop-down
list.

Correlations Click Font and
specify the dis-
play properties
for correlation
names that
appear on
either side of
the vertical
scale.

Node size Select a node
size from the
drop-down list.
If drawing geo-
logical anom-
alies with
correlation
lines, you may
want to
increase the
node size to
see what affect
the anomalies
have on adja-
cent time mark-
ers when you
flatten and
unflatten the
model. You can
drag nodes.

Flatten Select a cor-
relation upon
which to flatten
or click None.
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Flatten edges of model Click to align
the start and
end points of a
correlation with
the adjacent
correlation
nodes that
appear within
the canvas bor-
ders.

Trace / color property Select whether
depth traces
are based on
transit, dens-
ity, or imped-
ance. For
example, if
your density
log is inac-
curate and
there's little
velocity con-
trast, select
Transit, but for
horizons with
high density
contrast, for
example, lime-
stone over por-
ous dolomite,
select
Density.

Show only '_ Velocity' well
logs

This setting is
based on the
settings in the
Display Para-
meters: Global
tab.

Trace overlay every Select whether
to display
every trace or
every second
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or third trace to
determine how
velocity field is
being inter-
polated.

Color underlay Lithology
underlay

Specify
whether the
underlay is
based on color
values or litho-
logy. You con-
figure lithology
on a zone by
zone basis
using the Edit
Zone Para-
meters dialog
box . Generally,
the Range
check box
should be
cleared so you
have more con-
trol over the
depth model
presentation.

Impedance field inter-
polation cues

Select whether
arrows that
indicate the dir-
ection in which
the impedance
field was inter-
polated appear
on the depth
page.
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Depth markers Select the fre-
quency of
depth markers.

Show crossplots on this
page

Select whether
the crossplot
appears on the
depth page or
is hidden.

Parent Topics
"Changing depth models" on page 91

Display parameters: Global
With this feature... Do this...

Text Banner Type the
text to dis-
play in the
top-left
corner of
both the
time and
depth
pages.

Graphics Banner Select
whether an
image in
enhanced
metafile
format
appears.
Click Edit to
display the
Enhanced
Metafiles
Properties
dialog box
then browse
to and
select the
image, or
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with the
image
copied into
the Win-
dows Clip-
board, click
Paste.

Units Select
whether to
apply Imper-
ial or Metric
units
throughout
the model
and the
related incre-
ment.

Sonic Units Specify
whether the
time and
depth mod-
els are
based on
transit or
velocity
units. Your
selection
affects
which over-
lay and
underlay
options you
can select in
the Display
Parameters:
Time Model
dialog box.

Undo levels Select the
number of
successive
actions you
can undo
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and redo.

Printer Type a per-
centage by
which to
increase the
plotting
scale for
laser jet
printers,
which can
vertically
compress
models by
up to 2%.
And select
whether a
page outline
appears on
the model
bounding
the portion
of the model
that will fit
on the cur-
rently selec-
ted page
size. 

Warnings Display a
warning
message
when import-
ing a log
that's not
defined in
the Prop-
erties: Log
Defaults dia-
log box.

Parent Topics
"Changing global properties" on page 4
"Properties: Log library" on page 261
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Display parameters: Time model - display
With this feature... Do this...

# Depth/time traces Type the total number of
traces to display in the
time model. This number
affects the depth model if
you selected a value in the
Trace overlay every
drop-down list in the Dis-
play Parameters: Depth
Model tab. It also affects
where you can place a well
on the depth page
because a well can only be
placed on a trace.

Duplicates (at wells) Type the number of times
to copy the non-inter-
polated trace from each
well. Copies appear along-
side the existing non-inter-
polated trace. Click color
to change the color in
which duplicates appear.
To highlight non-inter-
polated traces, click High-
light well traces.

Display range Type the range for the ver-
tical scale. When the time
model isn't flattened, the
top of the model is zero,
when flattening is on, the
flattened correlation is
zero.

Scales Type the number of traces
per running unit for the
horizontal scale, and the
number of units per
second in the vertical
scale.

Correlations Select whether cor-
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relations drawn on the
depth page appear. Cor-
relations deleted on the
time page are also
removed from the depth
page.

Flatten Select a correlation upon
which to flatten.

Show well logs Select whether to display
well logs on top of the seis-
mic cross section.

Trace overlay Select whether to display
a trace overlay and
whether the trace shows
velocity, wiggle, or transit
readings. Clearing this
check box and selecting
the Underlay check box
below helps you detect
washouts.

Amplitude Type the display amp-
litude of the trace data.

Color underlay Select whether to display
a color fill then click Edit
to select the colors to use
and whether to display a
color bar reference to the
right of the model.

Range Select whether the color
range is based on the min-
imum and maximum val-
ues inherent in the model
or based on minimum and
maximum values you
type.

198 © 2020 IHS Markit™. All Rights Reserved



Appendices

Quick Change Select common cus-
tomizations.

Legend Click Font and specify the
display properties for
trace information that
appears above the model
adjacent to the logo.

Timing lines Select whether and the fre-
quency with which timing
lines appear.

Parent Topics
"Changing time models" on page 70

Display parameters: Time model - multi-offset
With this feature... Do this...

Ray trace method Select Dix NMO
for a preliminary
fast view, or
Ray trace for
improved accur-
acy using a full
Snell's law ray-
tracing
algorithm.

Vertical sampling Type the incre-
ment for time
sampling.

Depth range Select the depth
interval to
sample either
by subsea depth
or by correlation
zone. Limiting
the range
reduces the
time it takes
GeoSyn to gen-
erate the
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AVO model.

CDP interval Type a value
that matches
the common
depth point inter-
val of the seis-
mic to which the
model will be
compared. CDP
is half of the sur-
face offset.

Num traces Type the total
number of
traces to display
in the model.

Sum traces Select whether
to show indi-
vidual traces for
each receiver
and whether to
sum all the
traces into one
trace displayed
to the left of the
model. Click
Edit to display
the Sum
Options dialog
box where you
define groups of
traces (near,
middle, far) and
then do math-
ematical oper-
ations between
the three
groups, which
enables you to
filter or enhance
certain portions
of the offset
trace. For
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example, you
might subtract
the far traces
from the near
traces and then
multiple the res-
ult by the far
traces to
enhance the far
offset amp-
litude.

Near trace offset Type the dis-
tance from the
source at which
the nearest
receiver
appears. The dis-
tance to other
receivers is cal-
culated using
this value, the
CDP interval,
and the Num
traces values
above.

Mute Apply an inside
or outside angle
outside of which
data won't be
included in the
trace. The incid-
ent angle is cal-
culated at each
sample. The
mute line is
drawn on your
synthetic to
show where
data is being
cutoff. Select
the color in
which this line is
drawn using the
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Mute color drop-
down list.

Parent Topics
"Changing time models" on page 70

Display parameters: Time model - parameters
With this feature... Do this...

Sample rate Select the time
between successive
samples of the digital
time series. Sample
rate is in two-way
time. To prevent time
aliasing, wavelet fre-
quencies greater than
the nyquist frequency
should not be used.
The nyquist frequency
is equal to half of the
sampling frequency.

Wavelet Click to display the
Wavelet Properties:
Spectrum dialog box.

Model type Select either Zero off-
set model or click
Multi offset model
to enable the Multi-
Offset tab and to gen-
erate any sonic or
density logs required
for offset modelling.

Reflection Coefficients If all wells in your
model include density
logs, you can use a
combination of sonic
and density logs to cal-
culate the reflection
coefficient. If all of
your wells don't have a
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density log, you can
create one using Log
Editor.

AGC length ms Type a value for the
automatic gain control
applied to the data.
AGC uses a box car
method where a slid-
ing window calculates
an arithmetic average
that is used to nor-
malize the data point
in the center of the win-
dow. Set AGC to zero
for no automatic gain
control.

Noise Select the Apply
check box and then
click Edit to display
the Noise Para-
meters dialog box,
where you apply noise
type.

Multiples Select whether to dis-
play simulated first
order multiples along-
side primary reflec-
tions, or to just display
multiples and not the
primary reflection.
First order multiples
are the first reflection
of a primary reflection.

Parent Topics
"Changing time models" on page 70
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Display parameters: Wells
With this feature... Do this...

Width Type the width
to display the
wells selected
in the display
pane on the
depth page.

Position Type the dis-
tance to dis-
play the well
selected in the
display pane
from the left
canvas edge
on the depth
page.

Template Click Edit to
display the Edit
Multi-log per
track dialog
box and con-
figure track
properties
including which
logs appear in
various tracks.

Space evenly Sort east to
west

Click Update
to change wells
from pro-
portional spa-
cing to evenly
dispersed
along the cross
section. If spa-
cing evenly,
GeoSyn moves
interwell nodes
too. You can
only sort east
to west when
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there aren't
already cor-
relations drawn
in the depth
model.

Scale annotations Click Font to
change text dis-
play properties
and select an
increment for
the vertical
scale from the
drop-down list.

Markers Select the
increment for
major and
minor markers
from the drop-
down list.

Header annotations Click to display
the Edit Well
Header Display
dialog box and
select the
fields to dis-
play in the well
headers on
either the time
or depth
pages.

Trim wells Select whether
to trim wells by
Kelly Bushing
or Subsea
depths then
type the start
and stop depth
for the well. If
simultaneously
trimming mul-
tiple wells,
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select subsea.
Only the shal-
lowest start
depth and deep-
est stop depth
in the range
selected
appear, though
all wells are
trimmed.

Display pane Select the well
(s) to modify.
SHIFT+CLICK
or
CTRL+CLICK
for multiple
selection.

Export Click to display
the Export
Wells dialog
box and save
wells to disk in
either GeoSyn
or LAS format.

Logs Click to display
Log Editor.

Tops Click to display
the Top Prop-
erties dialog
box.
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Properties Click to display
theWell Prop-
erties dialog
box.

Duplicate Click to duplic-
ate the well
selected in the
display pane
then click the
depth model in
the location in
which to insert
it. If there are
correlations
already drawn
in the depth
model, the
Insert a well
into existing
model dialog
box auto-
matically
appears and
you correlate
the tops in the
duplicated well
with those in
the cross sec-
tion.

Delete Click to delete
the well(s)
selected in the
display pane.
CTRL+CLICK
or
SHIFT+CLICK
for multiple
selection.

Parent Topics
"Edit well header display" on page 220
"Changing well display properties" on page 88
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Edit default display properties
With this
feature...

Do this...

API num-
ber

Type the API number.

Alias Either type an alias in the box above the Add button and then
click Add to include it in the Alias list, or select an alias in the
Alias list and click Delete. Deleting aliases may prevent
GeoSyn from recognizing the aliases of imported logs in the
future.

Curve infill Select whether the log is colored with a scaled gradient or
based on lithology. Even with lithology selected, the lithology
of formation tops must be configured in the Top Properties dia-
log box before it appears in the main display.

Infill ori-
entation
Infill
palette

Select whether the positive or negative portion of the log is
colored. Custom color palettes aren't available for default
curve types.

Trace Select the display properties.

Metric to
Imperial
conversion
factor

Type the factor with which to convert Metric to Imperial.

Track
width

Type the desired track display width.

Lines Type Select whether lines appear on the log and whether they're log-
arithmic or linear.

Auto range Select to automatically adjust scales to data limits or clear and
type customminimum and maximum values.

Display in
velocity
units (for
sonic logs)

Select whether to display the log in velocity units and type the
range.

Parent Topics
"Changing log definitions" on page 105
"Properties: Log library" on page 261
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Edit a UWI
With this feature... Do this...

Survey system pane Click the desired survey
system tab and then
type coordinates for
either a UWI or UWI
range (depending on
how you launched this
dialog box).
Type ?? as a wildcard
when a specific value is
unknown.

Parent Topics
"Downloading logs from the IHS information hub" on page 15
"Changing well display properties" on page 88
"Directory Browser" on page 187
"Using Directory Browser" on page 19
"Well properties: Well properties" on page 283
Data Search Wizard: Search locations and ranges
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Edit color palette
With this feature... Do this...

Histogram
(appears for models and
some cross plots)

View where amplitudes
in the selected model
fall. A histogram is a
density graph, with
amplitude range along
the vertical scale and
bins along the hori-
zontal scale. Seeing
where the amplitudes
cluster enables you to
tailor the color display
accordingly so that a
fuller color spectrum is
expressed in the model
or cross plot. This is
done by dragging the
min max colors closer
to the bottom and top
of where most of the
amplitude data falls.
Note that for cross-
plots, the color ref-
erence type specified
in the cross plot dialog
box determines
whether the histogram
pane appears. For logs,
colors are typically
associated with par-
ticular values based on
lithology so it's not pos-
sible to override this
by dragging the min
max color nodes for
logs.

Palette Hover the cursor over
an adjacent node until
the cursor becomes a
square then click and
hold the mouse button
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while dragging the
color node up or down
to move the cor-
responding color.

Palette Name Type a unique name by
which to save the cur-
rent palette con-
figuration in the
GeoSynWorking dir-
ectory then click Save.

Palette selection Either select a default
palette that shipped
with GeoSyn or click
Load to browse to and
select a custom
palette you previously
created.

Drag and drop node col-
ors

Click and hold the
mouse button on a
color then drag it onto
either the color bar or
onto a node adjacent
to the color bar and
release the mouse but-
ton. If you release the
color on the color bar,
a new corresponding
node for that color
appears beside the
color bar.

Custom colors Click to display the
Custom Colors dialog
box where you click
the color to set as a
custom color, and then
drag the color to the
desired location on the
Palette strip to apply
it. Custom colors are
set in the registry so
that they persist

© 2020 IHS Markit™. All Rights Reserved 211



Appendices

across GeoSyn ses-
sions.

Nodes Select from the fol-
lowing:
Add to place additional
nodes beside the color
bar on which you can
drop colors.
Remove to delete the
last node placed.
Flip to flip the color
bar on its center hori-
zontal axis.
Even to evenly dis-
perse the existing
nodes along the color
bar.
Rotate to shift all the
colors one node down.
The bottom node
becomes the top node.

Color Interpolation style Select whether to dis-
play a color gradient or
solid color blocks.

Frequency Select so that the cen-
ter of the palette is
anchored to the center
of the amplitude data.
Clear to skew the col-
oring of the amplitude
points. You might
choose to skew the col-
oring for logs, but not
likely for models. Click
All to return the min
max colors to the bot-
tom and top of the his-
togram.

None Click to remove all
color from the color
bar.
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Parent Topics

Edit correlations
With this feature... Do this...

Display pane Select the correlation
with which to work.
SHIFT+CLICK or
CTRL+CLICK for mul-
tiple selection.

Correlation Name Type the desired name
to apply to the cor-
relation selected in the
display pane above
then click Update.

Delete All Select whether to
delete the correlation
selected in the display
pane above or all cor-
relations in the model.

Color drop-down list Select the color to
apply to the cor-
relations selected in
the display pane
above.

Parent Topics
"Create a new correlation" on page 176
"Create well correlations" on page 178
"Creating correlations" on page 94
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Edit labels
With this feature... Do this...

Display pane View whether an
image or annotation
appears on the
depth or time page,
then select a row to
change, delete, or
duplicate
(SHIFT+CLICK or
CTRL+CLICK for
multiple selection).

Text Click to create a
new row for a text
label in the adjacent
display pane then
type a more
descriptive ref-
erence for it in the
Text box below the
display pane and
click Update.

Symbol Click to create a
new row for a sym-
bol label in the adja-
cent display pane
then select a sym-
bol type from the
drop-down list
below the display
pane.

Import Click to browse to
an image file in .emf
format.

Paste Click to paste a
metafile image
copied to your Win-
dows clipboard from
another application
when you pressed
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ALT+PRINT SCRN.

Duplicate Click to make a
second copy of the
image selected in
the display pane
above.

Delete Click to delete the
rows selected in the
display pane
(CTRL+CLICK or
SHIFT+CLICK for
multiple selection).

Linkage Select whether the
label is floating,
which can be
dragged anywhere
in the model, or
anchored to either a
well or a position on
the canvas.

Link to depth KB For labels linked to
wells, specify a
fixed KB depth at
which to link it.

Size For symbols, select
whether to maintain
the label pro-
portions then type a
desired height or
width, or click and
hold the mouse but-
ton while dragging
one of the image's
handles in the main
display.
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Background Specify whether to
color the label back-
ground.

Border Select a border
style and color.

Font Click Edit to change
font display.

Parent Topics
"Displaying images and annotations" on page 92
"Changing global properties" on page 4

Edit lithology
With this feature... Do this...

Display pane Select the lithology for
which to change the color.

Click to display the Color
palette and using the
Colorpalette, click the
desired color for the litho-
logy selected in the Edit
Lithology display pane
above.
You can also click Define
Custom Colors to create
a color that doesn't
already appear in the
Basic colors options.
The new color is applied
to the lithology type
throughout this and future
cross sections.

Parent Topics
"Configuring Zones" on page 100
"Edit zone parameters" on page 221

216 © 2020 IHS Markit™. All Rights Reserved



Appendices

Edit correlations / nodes
With this feature... Do this...

Correlations Select the correlation
to show its cor-
responding nodes in
the Nodes pane. As
you select a cor-
relation, it's high-
lighted in the model
and you can change its
display properties
including name, line
style, and color.

Flatten edges of model Click to align the start
and end points of a cor-
relation with the adja-
cent correlation nodes
that appear within the
canvas borders.

Nodes Select the node to
change. As you select
a node, it's highlighted
in the model.

Delete Click to remove the
node selected in the
Nodes pane from the
model. You can't
delete nodes that are
latched to a well.

Offset Type the amount by
which to offset the
node to the right. You
can only change the off-
set when flattening
mode is off.

Depth SS Depth KB For nodes latched on a
well, type the desired
depth then click the
corresponding button.
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Parent Topics
"Creating correlations" on page 94

Edit EBCDIC header
With this feature... Do this...

Display pane Select a value to change
and then click Update.

Parent Topics
"Exporting time data" on page 141
"Assign geometry to seismic file" on page 166

Edit multi-log per track template
With this feature... Do this...

Template name Type a descriptive name
for the template to dis-
tinguish it from others
you create. The tem-
plate file is saved in the
GeoSynWorking dir-
ectory with the asso-
ciated description you
type.

Show empty tracks Select to display tracks
regardless of whether
they contain logs and
provided that Show
Track is also selected
on each individual tab
below.

Show track Select to display the
selected track provided
it contains a log. To
ensure the selected
track appears regard-
less of whether it con-
tains a log, also select
Show empty tracks
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above.

Track width | Following
gap

Type the width of the
track and the space
between tracks.

Scale type Select either Linear or
Logarithmic scale dis-
play types.

Minor division | Major
division

Depending on the scale
type selected above,
type either the minor
and major scale incre-
ments, or the left and
right scale.

Include curves of type Click Add to display the
Select from List dialog
box and select the log
(s) to add to the current
track. GeoSyn adds logs
from left to right and
any log not included in
one track becomes avail-
able to the next track to
the right.
To ensure GeoSyn
doesn't drop any logs,
for the last two tracks
select All remaining
linear curves and All
remaining log-
arithmic curves.

Import | Save Click to either load a
template from the
GeoSynWorking dir-
ectory or to save the
existing template.

Parent Topics
"Combining logs in tracks" on page 109
"Well properties: Log properties" on page 280
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Edit the derivation equation for log
With this feature... Do this...

Equation Modify the formula.

Function library Select a different library to
display a different formula,
or if you've modified the
equation, select a library to
revert to the original for-
mula.

Parent Topics
"Modeling fluid replacement" on page 134
"AVO log suite" on page 169
"Fluid replacement wizard: Calibrate shear log for water saturations < 100%"
on page 226

Edit well header display
With this fea-

ture...
Do this...

Drop-down lists Select the items to appear in the well header. Select
Unformatted UWI for malformed UWIs.

Font Click to set font display properties.

Select time/depth
well header to
match

Click to display identical well headers on the time and
depth pages.

Drop-down lists Select the field to display in the corresponding pos-
ition on the model.

Parent Topics
"Changing well display properties" on page 88
"Display parameters: Wells" on page 204
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Edit zone parameters
With this feature... Do this...

Zone list Select the zone or sub-
zone with which to work. By
default, selecting the zone
node selects all of the sub-
zones beneath that node to
which to apply changes.
You can select either a
single sub-zone or all of the
sub-zones within a Zone,
but not only some of the
sub-zones within a zone.
When highlighting is
enabled using the View
menu, as you select a zone
or sub-zone, the bound-
aries of that zone are high-
lighted on the depth model
(zones in yellow and sub-
zones in blue).

Interpolate Well For a zone that intersects a
well bore, select whether to
interpolate the velocity
field between wells by first
taking a value from the top
of the zone and then from
the bottom of the zone and
grading downwards (Top);
or by first taking a value
from the bottom of the
zone and then from the top
of the zone and grading
upwards (Bottom). If
there isn't sufficient data to
interpolate, select
Squeeze/Stretch instead.

Constant Type values for a constant
impedance field when you
don't have wells for an
area. To automatically
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change all zones in the
model, click Constant in
the Set all pane below.

Lithology Select whether to apply a
specific lithology to the
zone from the drop-down
list. Click Edit to display
the Edit Lithology dialog
box and change the color
applied to a lithology
throughout this and other
models.

Set all Click to apply the options
available in the Interpolate
Well and Constant areas
above to all zones through-
out the model.
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Display Lithology Select whether to color the
zone using the pattern
selected in the Lithology
drop-down list above. If
selected, the coloring won't
appear until you select a dif-
ferent zone or close this dia-
log box.

Show interpolation
cues

Select whether to display
arrows on the model that
indicate whether the zone
was interpolated from top

down ( ), bottom up ( ),

or by stretch squeeze ( ).

Interpolation Method Select either Type 1 or
Type 2 based on the fol-
lowing:
Type 1 (Recommended)
Starting at either the top or
bottom of the zone, depend-
ing on the Interpolate well
option selected above,
GeoSyn takes a data
sample from each well and
fills the distance between
wells using interpolation
based on distance and then
moves to the next data
point above or below the
current position and
repeats the above process.
If a pinch-out occurs where
one of the wells has no
more data, GeoSyn
switches from interpolation
to extrapolation mode
using the remaining data in
the other well. This rapid
switch from interpolation to
extrapolation mode over
only a single sample can
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generate a false reflection -
especially in zones with
strong horizontal velocity
gradients.
Type 2 Data values are
interpolated between two
points on adjacent wells
just as above, but when a
pinch-out occurs instead of
switching to extrapolated
mode, GeoSyn continues to
interpolate using the last
value from the well that ran
out of data. This may result
in an interpolation that's
heavily biased by the last
data value in the pinched
out wedge and if that value
is radically different than
other data in the well, it
may generate an incorrect
amplitude.

Parent Topics
"Configuring Zones" on page 100

Export wells
With this feature... Do this...

Selection criteria After specifying the Dis-
play parameters
below, click to display
the Selected curves
must have dialog box
and specify the para-
meters by which to
select logs in multiple
wells that appear in the
display pane.

Select all Deselect all Click to toggle all logs in
the display pane.

224 © 2020 IHS Markit™. All Rights Reserved



Appendices

Export format Select whether to export
logs in GeoSyn or LAS
format. GeoSyn format
includes more data than
LAS format that can be
loaded using GeoSyn 1D
or 2D.

Parent Topics
"Exporting logs" on page 142
"Auto curve selection" on page 263
"Display parameters: Wells" on page 204

Fluid replacement tool kit
With this feature... Do this...

Create Click to display the
AVO log suite dialog
box and derive the
logs required as input
logs for fluid replace-
ment modelling from
other logs in your
model. For example,
the shear log is typ-
ically derived from the
sonic log.

Duplicate Click to create exact
copies of existing logs
in your model for the
input logs.

© 2020 IHS Markit™. All Rights Reserved 225



Appendices

Hide new input logs Click this to prevent
the newly created
input logs from appear-
ing on your model.

Copy data Click to synchronize
the output logs with
the original input logs.
For example, if you've
substantially changed
data such as the depth
range. This button is
the equivalent to
Undo.

Parent Topics
"Modeling fluid replacement" on page 134
"Fluid replacement wizard: Input and output logs, depth range" on page 229
"AVO log suite" on page 169
Notes on GeoSyn fluid replacement

Fluid replacement wizard: Calibrate shear log for
water saturations < 100%
This dialog box only appears if the water saturation defined using the previous dia-
log box is less than 100%.

With this
feature...

Do this...

Apply cor-
rection
using
Mavko's
Procedure

It's recommended that you select this to compensate for the
fact that the shear log is frequently derived from a sonic log
using Castagna's formula. Castagna's formula requires a cor-
rection when gas is present in the zone of interest.

Edit Click to display the Edit the Derivation Equation for log dialog
box and change the formula.

Parent Topics
"Modeling fluid replacement" on page 134
"Edit the derivation equation for log" on page 220
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Fluid replacement wizard, FRM modeling: Set new
water saturation
With this fea-

ture...
Do this...

New Water Sat-
uration %

Drag the slider while viewing the effect in the Log Editor dia-
log box and in the model.
Click Apply to save these changes to the log.

Parent Topics
"Modeling fluid replacement" on page 134
"Fluid replacement wizard: In-situ reservoir properties" below
"Fluid replacement wizard: Calibrate shear log for water saturations < 100%"
on the previous page

Fluid replacement wizard: In-situ reservoir prop-
erties
With this feature... Do this...

Rock Matrix Select the reservoir rock
from the drop-down list to
populate the Bulk modulus,
Shear modulus, and Density
fields with typical values,
which you can change.
When you change a value,
the drop-down list above the
Bulk modulus field displays
Custom.
For detailed derivations,
click Calculator to display
the Minerals Calculator dia-
log box and specify the min-
eral composition in your zone
of interest.

Hydrocarbon Select the hydrocarbon to
populate the Bulk modulus
and Density fields, which you
can change.
When you change a value,
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the drop-down list above the
Bulk modulus field displays
Custom.
For detailed derivations,
click Calculator to display
the Batzle and Wang Fluid
Properties Calculator dialog
box and specify more precise
values for your zone of
interest.

Water/Brine Select the reservoir fluid to
populate the Bulk modulus,
Density, and Water sat-
uration fields, which you can
change.
When you change a value,
the drop-down list above the
Bulk modulus field displays
Custom.
For detailed derivations,
click Calculator to display
the Batzle and Wang Fluid
Properties Calculator dialog
box and specify values spe-
cific to your zone of interest.
For the Water saturation
value, instead of typing a
value, you can instead drag
the slider below the field.
Note that the fluid average
at the bottom of the dialog
box changes as you change
the water saturation per-
centage.

Fluid Average Select Reuss iso-stress if
fluid ratios are consistent in
pores throughout the zone of
interest; otherwise, select
Voight iso-strain.

Parent Topics
"Modeling fluid replacement" on page 134
"Fluid replacement wizard: Input and output logs, depth range" below
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"Batzle and Wang Fluid Properties Calculator" on page 169
"Minerals calculator" on page 251

Fluid replacement wizard: Input and output logs,
depth range

With this feature... Do this...

Log tool kit Click to display
the Fluid
Replacement
Tool Kit dialog
box to populate
the input and
output logs.

Input logs
(P Sonic, S Sonic, Density)

GeoSyn auto-
matically pop-
ulates these
boxes with P
wave, shear
sonic, and dens-
ity logs if
they're present
in your model.
Otherwise,
click Log Took
Kit above to
derive them
from other logs.
The input logs
are the source
logs for Gass-
man's equation.

Porosity Select either a
constant poros-
ity percent
(most com-
mon), or derive
the porosity per-
cent from a
density log.
Note that a
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porosity log
derived from a
density log may
not be accurate
for zones in
which gas is
present.

Porosity units Select a scale of
either 0-10 or
0-100. GeoSyn
analyzes the
data extents
and picks the
units that seem
most likely, but
you can over-
ride them if
some abnormal
data values
cause GeoSyn
to select the
wrong units.

Output logs Initially, these
are copies of
the input logs,
to which you
then apply fluid
replacement
changes.
Specify *Act-
ive logs in the
drop-down lists
so that fluid
replacement
changes are
automatically
reflected in the
current model.

Depth range KB Do one of the fol-
lowing:
Type start and
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stop depths and
click Update.
Click either
Top or Bottom
to select an
absolute depth
from the log, or
click All to
select both.
Click Range
from tops to
select a zone of
interest using
the formation
top names that
also appear in
the tops list
selected in the
Top Properties
dialog box.
Tip: You can
also use your
mouse pointer
to drag a spe-
cific zone on the
Log Editor to
specify a zone
of interest.

Parent Topics
"Modeling fluid replacement" on page 134
"Fluid replacement tool kit" on page 225

Import log data
With this feature... Do this...

Expand or contract
the nodes that
appear in the display
pane.

Auto select Display the Auto-
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matic
Curve selection dia-
log box where you
specify the prop-
erties of curves to
automatically select
in the Import Log
Data dialog box.

Add Select either of the
following:
Kingdom - display
the Kingdom Data
Browser dialog box
Disk- display the
Select Log Data... dia-
log box, where you
specify a local file in
.syn or .las format.

Restrict depth range Click to display the
actual depth spe-
cified in the file and
then type different
values in the adja-
cent boxes to change
the zone of interest.
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Order wells west to east Select whether to
order wells based on
the well identifier, or
click Order wells
manually to display
the Change well
Order dialog box
where you select a
well identifier and
click either Up or
Down. The top-most
well is displayed in
GeoSyn as the left-
most well.

Set model depth range to
minimum

Automatically
restrict the depth
range based on the
smallest depth range
common across all
wells.

Parent Topics
"GeoLaunching GeoSyn 2D from Kingdom" on page 6
"Importing LAS or GeoSyn files from disk" on page 18
"Auto curve selection" on page 263

Import tops
With this
feature...

Do this...

Top depth
placement

Select whether to space tops evenly or according to the kelly
bushing or subsea. If based on depth. tops outside of the
depth range of the model aren't placed.

Bulk shift
top depths
by + -

Type a negative or positive value by which to shift the top
depth.
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Import top
depths units

Select the measurement system GeoSyn is using.

Delete cur-
rent tops
before
importing
new tops

Select to delete all tops in the tops list to which tops will be
imported. If this check box is cleared, tops with the same
name in the donor and recipient list appear twice in the recip-
ient list.

File viewer If importing an ASCII format file, select the file and then click
to display the file contents in an ASCII text editor.

Parent Topics
"Importing tops from fixed width files" on page 35
"Importing tops from GeoSyn files" on page 42

Import wavelet processing flow
With this
feature...

Do this...

Apply
taper dur-
ing import

Select whether to apply tapering during import. Although
optional, if non-zero data is encountered near the end of an
imported trace, spurious high-frequency energy may appear in
the wavelet.

Wavelet
name

Type the name by which to identify the wavelet in the main dis-
play.

Operator
length

Type the operator length (longer operators include more detail)
at which to extract wavelets. Extracting wavelets using a long
operator enables you to shorten the wavelet length later
without damaging the detail of the amplitude spectrum. GeoSyn
saves only the amplitude and phase spectrums, and calculates
time wavelets as required.

Taper Select the taper method to apply to the operator that's extrac-
ted from the import trace after it's auto-correlated.

Parent Topics
"Importing wavelets and sets" on page 77
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Insert a well into an existing model
With this feature... Do this...

Edit To automatically
link correlations,
click to display the
Top Properties dia-
log box and type
top names that
match correlation
names and auto-
matically link them
by clicking the
Auto Correlate
button below.

Well Tops To manually link
tops to cor-
relations, click a
top to link to an
existing correlation
then click the cor-
relation in the Inter-
secting
correlations pane.

Auto Correlate Click to link top
names you created
using the Edit
option above to
matching cor-
relation names.

Clear Click to erase all
links between tops
and correlations.

Parent Topics
"Inserting log sections" on page 117
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Insert constant value log section
With this
feature...

Do this...

Insert at Select either depth or time and then either type a depth below
or above which to insert a log section or click Top or Bottom to
select the absolute top or bottom of the log.

Insertion
range

Select either depth or time and then type a depth thickness to
insert.

Insertion
values

To adjust the value inserted in various logs, select the desired
row and type a constant value to insert in the Edit log inser-
tion value box.

Resetting
top or bot-
tom of
well

Select whether to raise the start depth or lower the stop depth
to accommodate the insertion.

Parent Topics
"Inserting log sections" on page 117

Kingdom import horizon picks
Drop
down
list

List of available surveys tied to selected well

Visible
only

Selects only active surveys

2D
search
radius

Custom search radius setting for 2D seismic lines

Retrieve
1 picks

Select either:
l Time picks

l Depth picks

Tie to
well

Select picks from either:
l Surface
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Visible
horizons
only

Display only active horizons

Depths
in KB

Toggles pick list between KB or SS

Horizon
list

List of available horizon picks to import

Import Imports selected horizon picks.
Note: Kingdom time picks are converted to depth picks in order
to display in GeoSyn as a top.

Parent Topics
Top Properties

Kingdom import tops by author

With this
feature...

Do this...

Author
list

Click which author(s) to import tops from.

Parent Topics
Top Properties

Log blocking
With this feature... Do this...

Auto-block by culling val-
ues...

Select the range
above which to
ignore readings

Block between Tops Select whether to
apply a mean,
median, or RMS con-
stant average to the

© 2020 IHS Markit™. All Rights Reserved 237



log portion between
the shallowest and
deepest top within
your selection.
Remove the top and
bottom zones, which
can skew the model
with inaccurate data.

Log list Select the log to
block.

Set depth range KB Type start and stop
depths and click
Update.
Click either Top or
Bottom to select an
absolute depth from
the log or click All to
select both.
Click Get range
from tops to select
a range using the
formation top names
that also appear in
the tops list selected
in the Top Properties
dialog box .

Parent Topics
"Creating Blocked Log Models" on page 119
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Log composite
With this feature... Do this...

Unmatched Drag logs that
weren't auto-
matically
matched to
the desired
host log in the
Matched pane
or drag
matched logs
from the
Matched pane
into the
Unmatched
pane to
remove the
association.

Matched Drag the left-
most cell up
or down to a
different log
to change an
association.

Resort Select either
Alias or
GeoSyn
name. Typ-
ically the
most accur-
ate option is
GeoSyn
name.

Range Do one of the
following:
Type start
and stop
depths and
click Update.
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Click either
Top or Bot-
tom to select
an absolute
depth from
the log.
Click Depths
from tops to
select a range
using the
formation top
names that
also appear in
the tops list
selected in
the Top Prop-
erties dialog
box .
The selected
donor depth
range must
fall within the
host depth
range.
To add the
donor log sec-
tion to the
base of the
host well, in
the Host
replacement
depth range,
click Bottom
to display the
exact base of
the host well
and then type
this value in
the donor well
Top box.

Raise log data and tops above the
insertion Lower log data and tops
below the insertion

Select
whether to
move over-
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lapping data
in the host log
above or
below the
insertion.

Copy tops Select
whether to
copy tops
from the
donor well to
the host well.
These tops
are copied to
the Generic
tops list.

Parent Topics
"Creating log composites" on page 129

Log editor
The Log editor allows you to edit and manipulate well logs.

To open the Log editor:

l Edit > Log editing

l Double click on a log in the model.

l Right-click on a log and select Log editing.
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Log tabs across
the top —Click
to view and
work with dif-
ferent logs. Drag
tabs left or right
to change order.

Draw a free-
hand line.

Draw a straight
line.

Redraw all or
some of the log
as blocks using
an averaging or
a culling
method.

Insert a new log
section.

Stretch or
squeeze a log.

Clip or filter a
log.

Apply a math
equation to a
log.

Remove a seg-
ment from a log.

Model different
water saturation
effects on the
log.

Model different
porosity levels
on the log.

Create a log
composite by
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inserting log
data from
another well.

Merge two logs.

Shift a log rel-
ative to other
logs by depth.

Insert a top at a
location you
click on the log.

Undo and redo
previous
changes.

Zoom a log por-
tion in or out.

Expand or con-
tract the Log
Editor tab dis-
play.

Change the min-
imummaximum
values of the log
scale.

Close the Log
Editor

Parent Topics
"Drawing Straight Edge and Freehand Curves" on page 116
"Creating Blocked Log Models" on page 119
"Stretching and squeezing Logs" on page 120
"Applying math equations to logs" on page 124
"Modeling fluid replacement" on page 134
"Creating log composites" on page 129
"Changing log editor display" on page 114
"Inserting log sections" on page 117
"Inserting tops" on page 118
"Clipping or filtering logs" on page 122
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"Cutting logs" on page 128
"Shifting logs" on page 132
"Log editor display properties" on page 264

Math: Predefined functions
With this feature... Do this...

Function library Select from
numerous
pre-defined
log equa-
tions.

Log identifiers Click to place
logs in the
Equation
box or simply
view to cor-
relate vari-
ables in the
formula with
their asso-
ciated log.
Click Create
new log to
create a new
log populated
with values
from an equa-
tion that uses
existing logs.
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Create new log Click to
derive a new
log by apply-
ing the math-
ematical
function to
the log selec-
ted in Log
Editor.

Define range KB Do one of the
following:
Type start
and stop
depths and
click Update.
Click either
Top or Bot-
tom to select
an absolute
depth from
the log or
click All to
select both.
Click Depths
from tops to
select a
range using
the formation
top names
that also
appear in the
tops list selec-
ted in the
Top Prop-
erties dialog
box .

Reset output log scales Select to
reset the log
scales based
on the res-
ulting data
range.
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Math: User defined functions
With this feature... Do this...

Top box Type your equa-
tion directly in the
box or click Cal-
culator pad to
populate the box
using a calculator
interface.

Calculator pad Click to populate
the above box
using a calculator
interface. The cal-
culator interface
includes a Depth
button that gen-
erates a depth
value of the
sample

Function library Select from numer-
ous pre-defined
log equations.

Log identifiers Click to place logs
in the Equation
box or simply view
to correlate vari-
ables in the for-
mula with their
associated log.
Click Create new
log to create a
new log populated
with values from
an equation that
uses existing logs.

Create new log Click to derive a
new log by apply-
ing the math-
ematical function
to the log selected
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in Log Editor.

Define range KB Do one of the fol-
lowing:
Type start and
stop depths and
click Update.
Click either Top or
Bottom to select
an absolute depth
from the log or
click All to select
both.
Click Depths
from tops to
select a range
using the form-
ation top names
that also appear in
the tops list selec-
ted in the Top
Properties dialog
box .

Reset output log scales Select to reset the
log scales based
on the resulting
data range.

Measured depth to true vertical depth correction
With this feature... Do this...

Display pane Select the row to
adjust.

Insert Update Delete Select a row in the
display pane
above and click
one of the fol-
lowing:
Insert to add a
new row with the
values typed in
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the MD, Dip, and
Azimuth boxes.
Regardless of the
row selected, the
inserted row is
placed according
to its depth.
Update to apply
the values typed
in the MD, Dip, and
Azimuth boxes to
the selected row.
Delete to remove
the row.

Delete Click to remove
the row selected in
the display pane.

Input data set type Select from the fol-
lowing:
MD, AZ, DIP for
data that includes
azimuth and dip
data
MD, TVD, dX, dY
for data that
includes True Ver-
tical Depth, Delta
X, and Delta Y.
Delta X and Delta
Y values are
optional.
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Survey units are Select the units
used in the import
file. The default is
the unit type in
which the model is
displayed.

Import survey Click to display the
Import a Dir-
ectional Survey
dialog box and
browse to the file
to import. Impor-
ted files overwrite
values in the dis-
play pane above.

Save report Save the display
pane as an ASCII
text file.

Parent Topics
"Importing directional surveys" on page 23
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Minerals calculator
With this feature... Do this...

Mineral Click Select
to display
the Mineral
Selector dia-
log box for
up to five
minerals for
which
GeoSyn cal-
culates an
average
using either
the Voight-
Reuss-Hill or
Hashin-
Shtrikman
formulas spe-
cified.

Volume Type the per-
centage of
pore volume
this mineral
occupies.
Note that
you can't
proceed bey-
ond this dia-
log box until
the com-
bined
volume of
the minerals
you've selec-
ted equals
100%.

Matrix Averaging Formula Select
Voight-
Reuss-Hill
if the matrix
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is fairly
homogenous
for a straight
arithmetic
averaging
formula, or
select
Hashin-
Shtrikman
if the matrix
is more com-
plex.

Parent Topics
"Modeling fluid replacement" on page 134
"Fluid replacement wizard: In-situ reservoir properties" on page 227
"Mineral selector" below

Mineral selector
With this feature... Do this...

Rock Properties Click the mineral with
which to populate the
selected field in the Min-
erals Calculator dialog
box.

References If uncertain why to pick
one member over
another in the Rock Prop-
erties tab, note the num-
ber for each in the
Reference column and
then click the References
tab and scroll to the cor-
responding number for a
text and page reference
that describes the unique
properties of each.

Parent Topics
"Modeling fluid replacement" on page 134
"Minerals calculator" on the previous page
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Noise parameters
With this feature... Do this...

Signal to Noise Adjust the
signal to
noise
ratio.

Noise Type Select the
noise type
to apply to
the model.
Select
from
White or
Gaussian.

Band Limiting Select a
predefined
filter to
apply to
the model.

Parent Topics
"Changing time models" on page 70

Port hole
With this feature... Do this...

Grab Click to cap-
ture the por-
tion of the time
model cur-
rently dis-
played in the
Port Hole win-
dow.

Set Filter Click to display
theWavelet
Properties dia-
log box,
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change the
wavelet set-
tings, and then
click Grab
above.

Parent Topics
"Displaying multiple views of individually filtered time sections" on page 74

Print
With this feature... Do this...

Name Select a
printer or plot-
ter.

Properties Click to set
print prop-
erties. Options
in the Prop-
erties dialog
box are unique
to various
printers, so we
don't discuss
them here.
Refer to the
printer doc-
umentation for
details.
If using a plot-
ter, to cus-
tomize the
page size,
click the
Paper Size
tab then click
Properties >
MoreSizes.
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Print range Type the page
number range
to print.

Copies Select the num-
ber of copies
to print.

Parent Topics
"Printing models" on page 140

Print preview
With this fea-

ture...
Do this...

Print Click to display the Print dialog box and print directly
from the current dialog box.

Next page prev
(previous) page

If printing a multi-page layout, click to navigate
through the pages.

Zoom in Zoom out Click to zoom. Zoom Out is grayed out until you zoom
in one level.

Two Page One
Page

Click to specify whether this dialog box displays one or
two pages at a time.

Parent Topics
"Printing models" on page 140
"Print" on the previous page

Print setup
With this feature... Do this...

Name Select the
printer
model.

Properties Click to dis-
play the
Properties
dialog box
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where you
select
options
unique to
your
printer.
Note that if
you are
using a plot-
ter, you are
not limited
to the
paper sizes
shown in
the Size
box of the
Print Setup
dialog box .
To cus-
tomize your
page size,
click the
Paper Size
tab then
click Prop-
erties >
More
Sizes.

Paper Select the
Size and
Source
options spe-
cific to your
printer. For
example, if
you select
a plotter,
you will see
some large
paper sizes
in the Size
list. If you
are printing
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Letter size
paper, you
can also
select
which
paper tray
you want to
print from
in Source.

Orientation Select Por-
trait or
Landscape
orientation.

Network This func-
tion is not
discussed
as it is spe-
cific to your
computer
network.

Parent Topics
"Printing models" on page 140

Properties: Configuration
With this
feature...

Do this...

Executables View the directory where GeoSyn operational files are loc-
ated. For standalone installations, the Executables andWork-
ing directories are the same. For networked configurations,
the Executables directory is shared.
Changing this directory may prevent GeoSyn from locating
both the licensing file it requires to launch, and the IHS Inform-
ation Hub download parameters.

Working View the directory where customizable files such as color
palette, log import defaults, and user default files are located

or click browse ( ) to change it. To maintain the integrity of
each users' custom settings, it's recommended that the Work-
ing directory not be shared.
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GeoSyn
Addresses View GeoSyn contact information and click browse ( ) to

write an email message or launch the IHS web site.

IHS Online
Data
Retrieval
Info

View information required to connect to the IHS Online Data
Hub. For network installations, these settings affect all users.
If you don't have a subscription to download online digits,
leave these boxes blank.
Changing this connectivity information may prevent GeoSyn
from downloading online digits.

User name
Show trans-
action warn-
ing prompt

View or type your user name and toggle whether to display a
warning message when downloading digits may incur a
charge.

Parent Topics
"Configuring GeoSyn defaults" on page 5
"Downloading logs from the IHS information hub" on page 15
"Properties: Import defaults" on the facing page
Data Search Wizard: Select data from catalog
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Properties: Import defaults
With this feature... Do this...

Current default file From the drop-
down list, select a
default file to
either modify or
apply to the cur-
rent model, or
click New to dis-
play the New
default file name
dialog box and
type the name of
the default file to
create that inher-
its settings from
the current
model.
Default files are
saved in the
GeoSynWorking
directory and as
part of the cur-
rent model con-
figuration.

Update current default file
with model

Write the con-
figuration set-
tings in the model
to the default file
selected in the
Current default
file drop-down list
above.

User Paths Click to display
the Set Source
and Target Dir-
ectories dialog
box where you
click ... to define
the location of log
files to import and
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export.

Update model with current
default file

Apply the con-
figuration set-
tings from the
default file selec-
ted in the Current
default file drop-
down list above
to the model,
overwriting any
configurations
you may have
made in the cur-
rent file.

Default file description Double-click each
heading or click +
and - to expand
and contract
related properties
beneath each
node. The para-
meters in the
default file tree
display the set-
tings of the
default file selec-
ted above.

Parent Topics
"Changing import defaults" on page 13
"Import log data" on page 232
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Properties: Log library
With this feature... Do this...

Display pane To view current
default settings,
double-click node
text or click + and
-.

New curve Click to display the
Create New Curve
Type dialog box and
specify default para-
meters for a new
curve.

Delete curve Click to delete the
selected curve
type. Curves that
can be used as act-
ive logs (sonic,
shear sonic, time
depth, density, and
poisson's ratio)
can't be deleted.
Deleting logs may
prevent GeoSyn
from recognizing
imported log ali-
ases.
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Edit curve Click to display the
Edit Default Display
Propertiesdialog
box where you
change curve dis-
play properties and
create curve equa-
tions for only the
current curve type.
To change prop-
erties for any curve
type, click Edit
Curve Equations
below.

Edit Curve Equations Click to display the
Log Equation
Library dialog box
where you change
curve display prop-
erties and create
curve equations for
any curve type.

Export alias list Click to export a list
of all the aliases
GeoSyn uses to
recognize imported
logs.

Parent Topics
"Changing log display properties" on page 106
"Changing log definitions" on page 105
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Auto curve selection
With this feature... Do this...

Curve type Select this check box and
then click the curves to
include in the curve dis-
play pane in the lower-
left of the dialog box. Fur-
ther select whether all of
duplicate curve types
should be included from
each well, whether all of
the selected curve types
must be present for a
well to be included, and
whether the current
selections should be
used as your default
curve selections in future
sessions.

Author Select and then specify
the author(s) of curves
to include.

Deviation status Select and then specify
either measured depth or
true vertical depth meas-
urements.

Deviation Survey Select whether to include
deviation surveys.

Depth Select whether to include
logs with a depth greater
than or less than values
you type.

Depth increment Select and then type a dif-
ferent depth increment.

Parent Topics
"Downloading logs from the IHS information hub" on page 15
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Log editor display properties
With this feature... Do this...

Display pane Select a log to modify.
You can only select one
log at a time, but you
can apply scale changes
to all logs by clicking All
below the display pane.

Show off-scale Select whether red lines
appear in Log Editor
beside amplitudes that
exceed the minimum
and maximum scale val-
ues.

Show tops name Select whether to dis-
play formation top
names in Log Editor.
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Multi-log per track Click to display all logs
in the same track then
select or clear the Show
check box in the display
pane above. The log
selected in the display
pane above is high-
lighted blue in the track
(providing Use log dis-
play color is cleared
below) and you can edit
it using another dis-
played log as a ref-
erence.

Use log display color Select whether traces
appear in the track in
the color you set in the
Well Properties: Log
Properties dialog box . If
this option is selected
and Multi-log per track
is also selected above,
traces aren't highlighted
blue.

Velocity Transit If a sonic log is selected
in the display pane
above, select whether it
displays velocity or
transit units.

Parent Topics
"Changing log editor display" on page 114
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Shift curve
With this feature... Do this...

Shift selected curves Type the amount
by which to raise
or lower the
selected logs. A
positive value
raises the log
and a negative
value lowers it.

Display pane Select the logs
to shift. GeoSyn
automatically
shifts all logs
when one log is
shifted.
SHIFT+CLICK or
CTRL+CLICK for
multiple selec-
tion.

Parent Topics
"Shifting logs" on page 132
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Time filter
With this feature... Do this...

Type Select a predefined fil-
ter to apply:

l Band pass
(Ormsby) -—
computed from a
trapezoidal fre-
quency spec-
trum.

l Ricker -—
defined by its
peak frequency.

l Butterworth -—
computed from
low and high pass
cutoff frequency
values.

l Butterworth
low-pass -—
computed from
low pass cutoff
frequency values.

l Lobeless -—
non-sizable wave-
let distinguished
by the lack of
side lobes.

Center phase Type a value or drag
slider to move the
wavelet relative to the
center point displayed
in the Wavelet tab.

266 © 2020 IHS Markit™. All Rights Reserved



Taper Select equation type to
apply to taper : None,
Cosine, Cosine
squared, Hanning

Length (ms) Enter value for length
of sample time in ms.

Top properties
Tops:[list
name]

Highlighting individual tops selects them for editing,
deleting, or copying.

Show all Shows all tops on model and table.

Hide all Removes all tops frommodel and table.

New Click to create a new top.
Note:When a new top is created, the attributes in the
Edit Top(s) fields are applied to the new top. Best prac-
tices are to enter the new tops attributes in the Edit top
(s) fields before clicking New.

Duplicate Duplicates highlighted top.

Delete Delete All or Highlighted tops from list.

Copy tops list to
list

Select the tops in the Tops for list pane and then click
this button and select the destination list from the
Select a recipient tops list dialog box.

Select All Click to highlight all of the tops in current list.

Edit tops Edit the display properties for the selected top.

Name Highlighted tops name

Depth Selected depth

Attributes l Lithology

l Color

l Thickness

Tops lists Available Tops lists to select tops from.

Show all Displays tops from all tops lists on the synthetic display.
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Hide all Removes all tops lists them from synthetic display.

Export Outputs the tops to an ASCII format file.

Import Selects type and file for imports tops lists.

List Labels Enter top label information.

Plot tops
labels

Select side of logs that labels appear.

AccuMap spe-
cific

Requires licensed installation of AccuMap. See AccuMap
documentation for additional information.

Kingdom spe-
cific

Imports and displays Kingdom specific data items for selec-
ted:

l Horizon time or depth picks

l Tops by specific authors

Parent Topics
"Changing tops properties" on page 31
"Changing import defaults" on page 13
"Exporting tops lists" on page 146
"Duplicating tops lists" on page 49
"Create new curve type" on page 176
"Tops import" below
"Edit default display properties" on page 208
"Importing tops from GeoSyn files" on page 42
"Importing tops from delimited files" on page 32
"Importing tops from fixed width files" on page 35

Tops import
With this
feature...

Do this...

Display
Pane

Drag to select the tops to import into GeoSyn.

Tops in Select whether the tops in the source file are ordered in rows
(formation top names run horizontally along a single row), or
columns (formation top names run vertically down a single
column).
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Names in
row/column
Depths in
row/column

Depending on your selection above, this field changes to sup-
port either rows or columns. Specify the row or column in
which the formation names and depths appear. Click the dir-
ectional arrows to either move forward or backward by one
column or to move to the first or last column.

Search GeoSyn automatically searches the formation tops import file
for a UWI that matches the well currently displayed in GeoSyn
and highlights it in red. You can override this selection by typ-
ing a different UWI.

Import Click to import the tops selected above into GeoSyn.

Delimiter
Qualifier

GeoSyn automatically interprets this information from the
source file. You can override GeoSyn's comma, tab, or space
selection. Delimiter is the character that denotes each indi-
vidual item to import. Qualifiers are symbols that enclose
items to ignore.

Locate at
specified
depths
Ignore
depths and
space
evenly

Select whether to space tops evenly or according to the kelly
bushing or subsea. If based on depth. tops outside of the
depth range of the model aren't placed.

Import
units

Select the measurement system used in the file from which
you're importing tops. GeoSyn will convert them to the unit
system GeoSyn is using if required. The unit system GeoSyn is
using appears after the Bulk shift top depths by option below.

Depths are
relative to
KB SS

Select whether to space tops according to the kelly bushing or
subsea.

Bulk shift
top depths
by

Type a negative or positive value by which to shift the top's
depths in GeoSyn.

Delete cur-
rent tops
before
importing
new tops

Select to delete all tops in the tops list to which tops will be
imported. If this check box is cleared, tops with the same
name in the donor and recipient list appear twice in the recip-
ient list.

Parent Topics
"Importing tops from delimited files" on page 32
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"Top properties" on page 268
"Import tops" on page 234

Stretch/squeeze log curves in time
With this feature... Do this...

Stretch/squeeze in time
Stretch/squeeze in depth

Select either time
or depth based on
the following:
Time to modify the
transit values
through the selec-
ted depth zone. The
change in the sum
of all the transit
time changes must
equal the desired
stretch/squeeze
value.
Depth to stretch or
squeeze the selec-
ted depth range to
the thickness
defined.

Thickness
(when Stretch/squeeze in
depth selected)

Type the desired
thickness of the
zone defined above
after stretching or
squeezing. If the
value is less than
the difference
between the start
and stop depth, the
log will be
squeezed. If more,
the log will be
stretched.
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Change time interval by
(when Stretch/squeeze in
time selected)

Type a value by
which to adjust the
transit times for the
zone defined
above.

Taper the change over
(when Stretch/squeeze in
time selected)

Type the distance
over which to taper
the change. A
transit modification
must be tapered to
avoid creating new
reflection coef-
ficients at the top
and bottom of the
stretch/squeeze
zone. GeoSyn uses
a linear taper at the
top and bottom of
the zone where the
correction starts at
zero and tapers up
to a calculated
value, then tapers
down to zero again.
The length of the
taper is reported in
depth samples and
is the sum of the
top and bottom
tapers.

Set depth range Type a depth range
over which to taper
the change and
click Update.
Click either Top or
Bottom to select
the absolute top or
bottom of the log,
or click All to select
both.
Click Depths from
Tops and select the
top and bottom of
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your zone of
interest using form-
ation names.

Parent Topics
"Stretching and squeezing Logs" on page 120

Sum options
With this feature... Do this...

Range definition Either select
Auto or specify
the trace num-
bers to include
in the near,
middle, and far
groups.

Range relationships Using the drop-
down lists, cre-
ate math-
ematical
expressions to
filter or
enhance
traces.

Parent Topics
"Changing time models" on page 70
"Display parameters: Time model - display" on page 197
"Display parameters: Time model - multi-offset" on page 199
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Trim depth model
With this feature... Do this...

Trim by Click either Correlation
and select the correlation
above or below which to
trim from the drop-down
list, or select Depth SS
and type the subsea depth
above or below which to
trim (preface the value you
type with a minus sign to
signify below sea level).

Remove section Select whether to remove
a portion of the model
above or below the cor-
relation selected in the
drop-down list above and
the amount of model to
remove.

Parent Topics
"Trimming models" on page 104
"Display parameters: Depth model" on page 189

Wavelet properties: Spectrums
With this feature... Do this...

Display pane Select the wavelet
with which to work.
Clear Show all wave-
lets if you're already
working with the
desired wavelet to
increase the work
space in this dialog
box.

Name Type a name with
which the wavelet is
identified in the main
synthetic display.
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Type Select a predefined fil-
ter to apply to the
wavelet selected in
the display pane. Con-
trols to specify the cut
and pass frequencies
appear below based
on your selection.

Low cut Low pass High
cut High pass

Modify the energy
shape either by typing
the actual source val-
ues provided with the
seismic data or by
modifying the wavelet
shape to visually
match the seismic
data.

Center phase Type a value or drag
the slider to move the
wavelet relative to
the center point dis-
played in theWavelet
tab.

Taper Select whether to
taper using an equa-
tion.

Operator length Type the overall
length of the sample
to display in the adja-
cent window.

Import/Export Beside eitherWavelet
orWavelet sets
(depending on
whether to save a
single wavelet or
group of wavelets),
click Import or
Export to read or
write the wavelet or
wavelet set that

274 © 2020 IHS Markit™. All Rights Reserved



appears in the display
pane to or from disk.
To save or import a
wavelet(s) from a
centralized wavelet lib-
rary used by all
GeoSyn models,
beside the Library
label select either
Add to save the cur-
rent wavelet to the lib-
rary, or Retrieve to
display theWavelet
Library dialog box
where you apply one
or more wavelets to
the current synthetic.

Import Wavelet Select either of the fol-
lowing and then click:
Replace wavelets
in selected models
- overwrites the wave-
lets selected in the
Show wavelet list
pane of the Wavelet
Properties dialog box
with those selected in
theWavelet Library
dialog box.
Create new models -
adds the selected
wavelet alongside
other wavelets avail-
able in the synthetic.

Extraction Click Extract to load
a wavelet saved in
ASCII or SEGY format.
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Left right arrows ( ) Click to expand or
compress the spec-
trum.

Show Select whether to dis-
play the spectrum for
power, amplitude, and
phase.

Parent Topics
"Changing wavelet properties " on page 83
"Importing wavelets and sets" on page 77
"Exporting wavelets and sets" on page 144
"Extracting wavelets" on page 84
"Wavelet properties: Wavelet" below

Wavelet properties: Wavelet
With this feature... Do this...

Display pane Select the wavelet
with which to work.
Clear Show all
wavelets if you're
already working with
the desired wavelet
to increase the work
space in this dialog
box.

Name and Comments Type a name with
which the wavelet is
identified in the main
synthetic display.

Type Select a predefined
filter to apply to the
wavelet selected in
the display pane.
Controls to specify
the cut and pass fre-
quencies appear
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below based on your
selection.

Low cut Low pass High
cut High pass

Modify the energy
shape either by typ-
ing the actual source
values provided with
the seismic data or
by modifying the
wavelet shape to
visually match the
seismic data.

Center phase Type a value or drag
the slider to move
the wavelet relative
to the center point
displayed in the
Wavelet tab.

Taper Select whether to
taper using an equa-
tion.

Length Type the overall
length of the sample
to display in the adja-
cent window.

Import | Export Beside eitherWave-
let orWavelet sets
(depending on
whether to save a
single wavelet or
group of wavelets),
click Import or
Export to read or
write the wavelet or
wavelet set that
appears in the dis-
play pane to or from
disk.
To save or import a
wavelet(s) from a
centralized wavelet
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library used by all
GeoSyn models,
beside the Library
label select either
Add to save the cur-
rent wavelet to the
library, or Retrieve
to display theWave-
let Library dialog box
where you apply one
or more wavelets to
the current syn-
thetic.

Extraction Click Extract to load
a wavelet saved in
ASCII or SEGY
format.

Aux. trace Select an additional
trace to display in
the trace display
pane and a color
format. For example,
the Amplitude Envel-
ope shows where the
wavelet energy is
and helps you to
align the wavelet
phase.

Color Select a background
color for the display
pane.

Parent Topics
"Changing wavelet properties " on page 83
"Extracting wavelets" on page 84
"Exporting wavelets and sets" on page 144
"Importing wavelets and sets" on page 77
"Wavelet properties: Spectrums" on page 274
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Well properties: Directional properties
With this
feature...

Do this...

TVD vs. off-
set cal-
culator

Click the arrows to adjust the depth and offset values by 1,
10, and 100 respectively.

Horizontal
scale

Type a value for a horizontal scale to bridge the real world and
the display world. For example 100 m = 1 cm.

Show hori-
zontal devi-
ation

Toggle whether to display the horizontal deviation in the main
display.

Projection
azimuth

Type a value or hover the cursor over the compass then click
and drag to change the projection azimuth.

Parent Topics
"Changing deviated well properties" on page 28

Well properties: Log properties
With this feature... Do this...

Display pane Select the log to
modify and either
change its display
properties or click
Duplicate then
change the display
properties of the
copied log. Click
New to create a
blank log type.
SHIFT+CLICK or
CTRL+CLICK for mul-
tiple selection, or
click Select All.

Name Type a descriptive
name with which to
overwrite the ori-
ginal log name.
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Type Select a log type
from the drop-down
list and whether to
make it the active
log upon which your
model is derived.

Alias / API Select an alias and
then type the API
number.

Units Type the unit suffix
and for sonic logs
either transit or velo-
city units.

Scales Select whether to
automatically adjust
scales to data limits
or type custommin-
imum and maximum
values.

Show offscale Select whether por-
tions of a log that
over-run the hori-
zontal width of the
track are drawn on
the other side of the
track in a different
color and different
line style. Log por-
tions that over-run
more than one track
are colored dif-
ferently than logs
that over-run only a
single track.

Infill If displaying a single
log per track, spe-
cify a lithology fill
and whether to fill
the left or right por-
tion of the trace.
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XPlot underlay link Select whether the
color infill for the log
is derived from a
crossplot. This
option is enabled
using the Crossplot
Properties: Color
Mapping tab.

Derive using Select to apply a con-
stant mathematical
formula to the selec-
ted curves that per-
sists despite
changes to the log.
Click Edit to launch
the Edit the deriv-
ation equation dia-
log box and specify
different variables.
Note that selecting
this option will pre-
vent you from doing
some log editing
functions.

Trace Select display prop-
erties for the logs
selected in the dis-
play pane above.
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Track Width Specify the width at
which the track will
be printed.

Properties common to all
logs

Select whether the
log name is cus-
tomized or based on
the criteria defined
in the default files.
Select the incre-
ments for major and
minor depth mark-
ers. Select whether
one log per track or
multiple logs per
track are displayed.
If multiple, click Edit
to display the Multi-
Log per Track dialog
box and configure
the track settings.

Parent Topics
"Changing log display properties" on page 106
"Combining logs in tracks" on page 109

Well properties: Well properties
With this feature... Do this...

Unique Well Identifier Click Edit to dis-
play the Edit a UWI
dialog box then spe-
cify a survey sys-
tem and survey
coordinates. Both
UWI labels update.

Labels Type any log
header information
to show in the main
display.

Status Select a well status
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from the drop-
down list and
whether to update
this status if it's
changed in the
AccuMap database.

KB elevation Type the kelly bush-
ing elevation.

Depth inc. Type the depth
increment.

TVD status Select whether the
well is measured in
True Vertical Depth
or Measured Depth.
If Measured Depth,
you can import an
ASCII format dir-
ectional survey file
by clicking the adja-
cent button.
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Import Directional Survey Click to launch the
Measured Depth to
True Vertical Depth
correction dialog
box. Also select
whether to cal-
culate the bottom
hole position based
on the directional
survey imported.

Editing History Click View to dis-
play a list of all
changes made to
the curve. Saved
changes span mul-
tiple GeoSyn ses-
sions.

Position Select whether to
use the default
datum, the datum
specified in the
AccuMap database,
or one based on
another standard
datum you select
or coordinates that
you type using the
Set Location dialog
box.

Parent Topics
"Changing well display properties" on page 88
"Changing import defaults" on page 13
"Importing directional surveys" on page 23
"Changing tops properties" on page 31
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Zero phase extraction processing flow
With this feature... Do this...

Time range Sum traces Select the time
range and number of
traces to sum.

Taper Apply taper to Select the taper
method and per-
centage of the
summed traces to
taper.

Wavelet name Type the name by
which the resulting
wavelet is identified
in GeoSyn.

Operator length Select the longest
operator possible to
ensure the amplitude
spectrum retains as
much detail as pos-
sible.

Taper Select the method
by which to taper the
operator extracted
from the center of
the summed and
tapered traces.

Parent Topics
"Extracting wavelets" on page 84
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File formats
The following supported file formats are defined below:

l GeoSyn 2D depth model format

l SYN

l LAS

l SEGY

GeoSyn 2D depth model format
GeoSyn2D generates impedance vs. depth field as the first step in creating a time
model. This field is exportable as an ASCII format file.

The file begins with a brief header area with information on the depth model para-
meters and a description of the Data Field Format. This area is followed by a data
block made up of records described in the Data Field Format.

// GeoSyn2D Depth Field
// Date: 08:01 AM Thu Jan 19, 2006
//
// Depth Units : meters
// Model top : 0.0
// Model bottom : -1600.0
// Depth increment : 0.3048
// Model width : 6500.0
// Offset increment : 132.653059
// Data Field Format: COLUMN,ROW,X_M,Y_M_SS,P_VELOCITY
//
//
0,0,0.0,0.0,3827.147
0,1,0.0,0.3048,3827.147
0,2,0.0,0.6096,3827.147
0,3,0.0,0.9144,3827.147
0,4,0.0,1.2192,3827.147
0,5,0.0,1.524,3827.147
0,6,0.0,1.8288,3827.147
0,7,0.0,2.1336,3827.147
0,8,0.0,2.4384,3827.147
0,9,0.0,2.7432,3827.147
0,10,0.0,3.048,3827.147
0,11,0.0,3.3528,3827.147
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SYN file format
After you have created and saved a new synthetic, the synthetic is saved to disk
as a binary file with the optional extension .syn. This file contains all the inform-
ation necessary to re-create the state of the synthetic as well as the raw log
data.

LAS format
The Canadian Well Logging Society's Floppy Disk Committee has designed a
standard format for log data on floppy disks. It is known as the LAS format (Log
ASCII Standard). LAS consists of files written in ASCII and containing minimal
header information. The LAS format has evolved over the years. GeoSyn cur-
rently supports the import of two versions, 2.0 and 1.2.

GeoSyn will read an attached tops file, although strictly speaking tops are not
included in the official LAS format. Two styles of tops formats are supported in
Version 2.0, and one format is supported in Version 1.2.
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Truncated Example of LAS Version 2.0

~VERSION INFORMATIONVERS. 2.00:CWLS LOG ASCII STANDARD - VERSION
2.00WRAP. NO :One Line per depth step#~WELL INFORMATION#MNEM.UNIT
DATA DESCRIPTION#--------- ----------------------------------- -------------
-----------------STRT.M 249.7836 :START DEPTHSTOP.M 1254.2520 :STOP
DEPTHSTEP.M 0.1520 :STEP LENGTHNULL. -999.2500 :NULL VALUECOMP.
AnyCompany OIL & GAS LIMITED :COMPANYWELL. AnyCompany etal
AnyWhere :WELLLOC . AnyWhere :LOCATION#~CURVE
INFORMATION#MNEM.UNIT DATA DESCRIPTION#--------- -------------------
---------------- ------------------------------DEPT.M :1 DepthDT .US/M 7 520
80 00 :2 Sonic Travel TimeRHOB.G/C3 31 350 02 00 :3 Bulk Dens-
ity#~PARAMETER INFORMATION#MNEM.UNIT DATA DESCRIPTION#---------
----------------------------------- ------------------------------EKB .M
300.0000 :Kelly bushing#~t 7 Tops //or ~T 7 TopsT0 647.98T1 800.89T2
1011.86Wabamun 1132.40Ireton 1536.64Slave Point 1812.01Pre Cambrian
1841.80#~A DEPT DT RHOB249.7836 410.825 1819.972249.9356 410.752
1791.029250.0876 410.679 1802.005250.2396 410.607 1869.852250.3916
410.534 1908.247250.5436 410.461 1958.225250.6956 410.388
1987.873250.8476 410.316 2014.986250.9996 410.249 2022.811...1253.4396
169.758 2730.6461253.5916 169.758 2730.6461253.7436 169.758
2730.6461253.8956 169.758 2730.6461254.0476 169.758 2730.6461254.1996
58.382 939.106No special end of file characters are required.**alternate tops
format~Formation Tops Information#TOPS NAME . DEPTH:BR .
7221.0410:WPBI . 8034.6790:COLO . 8539.9220:CARD . 9553.6900:CARD .
9671.7980:L CA . 9743.9760:BKST . 9799.7500:
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Truncated Example of LAS Version 1.2

~Version : LASOUT vs 1.20VERS. 1.20: CWLS Log ASCII Standard -VERSION
1.20WRAP. NO: One line per depth step~Well Information Block#MNEM.UNIT
Data Type Information#----.---- ------------: ------------------------------
STRT.M 250.0000: Start DepthSTOP.M 2413.0000: End DepthSTEP.M .2000:
Depth IncrementNULL. -999.25:COMP. COMPANY:WELL. WELL: Dog Patch
LAKE 5-4FLD . FIELD: Dog PatchLOC . LOCATION: 10-10-99-1w6PROV.
PROVINCE: ALBERTASRVC. SERVICE COMPANY: FlyByNight LoggersDATE.
LOG DATE: 1889/12/29UWI . UNIQUE WELL ID: 0101010101010~Parameter
Information Block#MNEM.UNIT Value Description#----.---- ------------: -----
-------------------------BHT .DEGF .0000: Bottom Hole TemperatureBS .MM
.0000: Bit SizeDFD .0000: Mud Weight (Density)DFV .0000: Mud ViscosityDFL
. .0000: Mud Fluid LossDFPH .0000: Mud pHRM .OHMM .0000: Mud Res-
istivityRMT .DEGF .0000: Mud Resistivity TemperatureRMFS.OHMM .0000:
Mud Filtrate ResistivityRMFT.DEGF .0000: RMF TemperatureRMC .OHMM
.0000: Mud Cake ResistivityRMCT.DEGF .0000: RMC TemperatureEKB .M
987.5000: Elevation Kelly BushingEGL .M 982.3000: Elevation Ground
Level~Curve Information Block#MNEM.UNIT API CODE Curve Description#---
-.---- ------------: ------------------------DEPT.M : 1 DEPTHDT .USM 60 520 0
1: 2RHOB.KM3 42 350 1 1: 3~A Depth DT RHOB250.0000 376.4800
1922.6000250.2000 345.2000 1998.4000250.4000 313.9200
2363.4000250.6000 282.6400 2512.2000250.8000 254.4400
2463.2000251.0000 275.8800 2392.0000...2411.2000 -999.2500
2715.90002411.4000 -999.2500 2713.90002411.6000 -999.2500
2712.40002411.8000 -999.2500 2707.20002412.0000 -999.2500
2691.00002412.2000 -999.2500 2674.80002412.4000 -999.2500
2658.60002412.6000 -999.2500 2640.70002412.8000 -999.2500
2683.40002413.0000 -999.2500 2730.9000No special end of file characters
are required.

SEGY format
GeoSyn can export integrated time data (traces, wavelets, wells, rocs, etc.) in
SEGY format. The format specification discussed here is a derivative of the SEGY
9-track standard. Because there is no official MS DOS standard, some liberties
have been taken with respect to the original specifications. For a discussion of the
9-track SEGY format, refer to "Recommended Standards for Digital Tape
Formats" K.M. Barry, D.A. Cavers, C.W. Kneale: Geophysics, Vol. 40 No. 2, p.
344-352.

A SEGY file consists of three sections or blocks:
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l ASCII file identification header

l Binary file header

l Trace header

ASCII file identification header
The first 3600 bytes of the file is the File Identification Header and consists of a
3200-byte ASCII card image block followed by a 400-byte binary block. The
3200-byte ASCII section represents a deviation from the 9-track SEGY standard,
which specifies that this section be in EBCDIC format. Both are text formats, but
use of the ASCII format enables a user to read this portion of the SEGY file in any
PC-based text editor. This deviation from the standard has no detrimental effects
because most programs rely on the binary data for hard information.

The ASCII section consists of 40 lines of 80 characters each. Each line starts with
a C and the line number. The following is an abridged example of the 3200-byte
ASCII header for a typical GeoSyn SEGY file and describes the well name, sample
rate, data type, and byte order. This same information is encoded in the 400-byte
binary section.

C1 GeoSyn Synthetic Seismogram
C2 ABC OIL AND GAS 11-11-11-11W1
C3 Date: 11:35 AM Fri Dec 01, 1995�
C4 Sample Rate: 2.00 (ms)
C5 Data Type: Integer(2 byte)
C6 Byte Swap: Yes
C7
.....
C36
C37
C38
C39
C40

Binary file header
The 400-byte binary file header follows the ASCII file header and is situated on
bytes 3201 to 3600. GeoSyn does not require or make use of most of the space.

The following bytes are used:
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3213 to 3214 Number of byte traces per record =1
3217 to 3218 Sample interval in microseconds
3221 to 3222 Number of samples per data trace
3225 to 3226 Data sample format code (will be either 1 or 3)
1=floating point (4bytes)
2=fixed point (4 bytes)
3=fixed point (2 bytes)
4=fixed point with gain code (4 bytes)
3261 to 3262 Total number of traces per line =1
3269 to 3270 Start time of data trace (can be negative in the case of a wave-
let)

Trace header
The trace header is a 240-byte binary section that precedes each section of trace
data. GeoSyn only writes one data curve, so there is one trace header in the file.
The trace header occupies bytes 3601 to 3840. The bytes used by GeoSyn are tab-
ulated below. Note that some values are 4 bytes long instead of 2-byte integer.

The following bytes are used:

3601 to 3604 Trace Number.
3629 to 3630 Trace identification code 1=seismic data, 2=dead trace.
3715 to 3716 Number of samples.
3717 to 3718 Sample interval in microseconds.

Trace Data

Trace data is stored in binary format and follows the 240-byte trace header. The
binary data may be stored in one of two formats, 16-bit integer or IEEE floating
point. The 16-bit integer format requires 2 bytes per amplitude value, whereas
the floating point format requires 4 bytes.

Data Area

The data area follows the trace header and consists of a number of 2- or 4-byte
numbers representing the amplitude data of the trace or wavelet. Note that the
number of samples in this record will exceed the number of samples in the syn-
thetic if a trace is being saved, because the roll out portion of the trace below the
bottom of the log is included. The number of extra samples will equal the length of
the trace plus half the length of the wavelet operator.
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Well symbol legend
Location Suspended

Service or Drain Oil

Gas Dry and Abandoned

Heavy Oil Suspended Oil

Abandoned Oil Suspended Gas

Abandoned Gas Abandoned Service

Oil and Gas Suspended Heavy Oil

Abandoned Heavy Oil Suspended Oil and Gas

Abandoned Oil and Gas Injection
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